Before operating the unit, please read this handbook and “Instruction Manual” (separate volume) thoroughly, and retain them for future reference.

Owner’s Record
The model and serial numbers are located on the bottom. Record the serial number in the space provided below. Refer to these numbers whenever you call upon your Sony dealer regarding this product.

Model No. DSC-S45
Serial No. ___________________________
WARNING
To reduce fire or shock hazard, do not expose the unit to rain or moisture.

For Customers in the U.S.A.

CAUTION
RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK,
DO NOT REMOVE COVER (OR BACK).
NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol is intended to alert the user to the presence of uninsulated “dangerous voltage” within the product's enclosure that may be of sufficient magnitude to constitute a risk of electric shock to persons.

This symbol is intended to alert the user to the presence of important operating and maintenance (servicing) instructions in the literature accompanying the appliance.

This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) This device must accept any interference received, including interference that may cause undesired operation.

CAUTION
You are cautioned that any changes or modifications not expressly approved in this manual could void your authority to operate this equipment.

Note:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment and receiver.
– Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
– Consult the dealer or an experienced radio/TV technician for help.

The supplied interface cable must be used with the equipment in order to comply with the limits for a digital device pursuant to Subpart B of Part 15 of FCC Rules.
Notes on using your camera

Types of “Memory Stick” that can be used (not supplied)
The IC recording medium used by this camera is a “Memory Stick Duo”. There are two types of “Memory Stick”.

“Memory Stick Duo”: you can use a “Memory Stick Duo” with your camera.

“Memory Stick”: you cannot use a “Memory Stick” with your camera.

Other memory cards cannot be used.
• For details on “Memory Stick Duo”, see page 83.

When using a “Memory Stick Duo” with “Memory Stick” compatible equipment
You can use the “Memory Stick Duo” by inserting it into the Memory Stick Duo Adaptor (not supplied).

Memory Stick Duo Adaptor

No compensation for contents of the recording
• The contents of the recording cannot be compensated for if recording or playback is not possible due to a malfunction of your camera or recording media, etc.

Internal memory and “Memory Stick Duo” back up
• Do not turn off the camera or remove the battery pack or “Memory Stick Duo” while the access lamp is lighted, as the internal memory data or “Memory Stick Duo” data may be destroyed.

Always protect your data by making a back up copy. See page 22 for the data back up method.

Notes on recording/playback
• This camera is neither dust-proof, nor splash-proof, nor water-proof. Read “Precautions” (page 87) before operating the camera.
• Before you record one-time events, make a trial recording to make sure that the camera is working correctly.
• Be careful not to get the camera wet. Water entering the inside of the camera may cause malfunctions which in some cases may not be repairable.
• Do not aim the camera at the sun or other bright light. This may cause irrecoverable damage to your eyes. Or it may cause the malfunction of your camera.
• Do not use the camera near a location that generates strong radio waves or emits radiation. The camera may not be able to record or play back properly.
• Using the camera in sandy or dusty locations may cause malfunctions.
• If moisture condensation occurs, remove it before using the camera (page 87).
• Do not shake or strike the camera. In addition to malfunctions and an inability to record images, this may render the recording medium unusable, or cause image data breakdown, damage or loss.
• Clean the flash surface before use. The heat of flash emission may cause dirt on the flash surface to become discolored or to stick to the flash surface, resulting in insufficient light emission.

Notes on the LCD screen and lens
• The LCD screen is manufactured using extremely high-precision technology so over 99.4% of the pixels are operational for effective use. However, there may be some tiny black points and/or bright points (white, red, blue, or green in color) that constantly appear on the LCD screen. These points are normal in the manufacturing process and do not affect the recording in any way.
• Exposing the LCD screen or the lens to direct sunlight for long periods may cause malfunctions. Be careful when placing the camera near a window or outdoors.

• Do not press against the LCD screen. The screen may be discolored and that may cause a malfunction.

• Images may trail across on the LCD screen in a cold location. This is not a malfunction.

• This camera is equipped with a power zoom lens. Be careful not to bump the lens, and be careful not to apply force to it.

On image data compatibility

• This camera conforms with DCF (Design rule for Camera File system) universal standard established by JEITA (Japan Electronics and Information Technology Industries Association).

• Playback of images recorded with your camera on other equipment and playback of images recorded or edited with other equipment on your camera are not guaranteed.

Warning on copyright

Television programs, films, videotapes, and other materials may be copyrighted. Unauthorized recording of such materials may be contrary to the provisions of the copyright laws.

The pictures used in this manual

The photographs used as examples of pictures in this manual are reproduced images, and are not actual images shot using this camera.
For full use of the digital still camera

Prepare the camera and shoot images easily

“Instruction Manual” (Separate Volume)

Get more friendly with your camera

This manual

• Shoot with your favorite settings (Program auto shooting) ➔ page 24
• Enjoy various shooting/playback using the menu ➔ page 26
• Change the default settings ➔ page 37

Connect your camera to a PC or a printer

This manual

• Copy your images to a computer and enjoy editing them in various ways ➔ page 46
• Print images by connecting your camera directly to a printer (PictBridge compliant printers only) ➔ page 63
Table of contents

Notes on using your camera ................................................................. 3

Enjoying the camera

Basic techniques for better images .................................................. 9
  Focus – Focusing on a subject successfully ........................................ 9
  Exposure – Adjusting the light intensity ............................................ 10
  Color – On the effects of lighting .................................................... 11
  Quality – On “image quality” and “image size” ............................... 12

Identifying parts .............................................................................. 14

Indicators on the screen ................................................................... 16

Changing the screen display ............................................................ 20

Number of still images and recording time of movies ..................... 21

When you do not have a “Memory Stick Duo” (Recording with the internal memory) ................................................................. 22

Battery life and number of images that can be recorded/viewed .......... 23

Using the mode dial ....................................................................... 24

Using the menu

Using menu items ........................................................................... 26

Menu items ...................................................................................... 27

Shooting menu ................................................................................. 28

  (EV)
  (Metering Mode)
  WB (White Bal)
  ISO
  (P.Quality)
  Mode (REC Mode)
  PFX (P.Effect)
  (Saturation)
  (Sharpness)
  (Setup)
Using the Setup screen

Using Setup items ................................................................. 37

- Camera .............................................................................. 38
  - Digital Zoom
  - Date/Time
  - Red Eye Reduction
  - Auto Review

- Internal Memory Tool .................................................... 40
  - Format

- Memory Stick Tool .......................................................... 41
  - Format
  - Create REC. Folder
  - Change REC. Folder
  - Copy

- Setup 1 ............................................................................ 43
  - LCD Backlight
  - Beep
  - Initialize

- Setup 2 ............................................................................ 44
  - File Number
  - USB Connect
  - Video Out
  - Clock Set

Using your computer

Enjoying your Windows computer ........................................... 46
Installing the software (supplied) ........................................... 48
Copying images to your computer ........................................... 49
Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”) .......................................................... 55
Using the “Cyber-shot Viewer” (supplied) ........................................ 56
Using your Macintosh computer ..................................................... 60

Printing still images

How to print still images .................................................................. 62
Printing images directly using a PictBridge compliant printer .......... 63
Printing at a shop .......................................................................... 66

Connecting your camera to your TV

Viewing images on a TV screen ........................................................ 68

Troubleshooting

Troubleshooting .............................................................................. 70
Warning messages .......................................................................... 81

Others

On the “Memory Stick” .................................................................... 83
On the batteries ............................................................................... 85
Precautions .................................................................................... 87

Index ................................................................................................ 88
Enjoying the camera
Basic techniques for better images

This section describes the basics so you can enjoy your camera. It tells you how to use various camera functions such as the mode dial (page 24), the menus (page 26), and so on.

Focus
Focusing on a subject successfully

When you press the shutter button halfway down, the camera adjusts the focus automatically (Auto Focus). Remember to press the shutter button only halfway down.

Press the shutter button fully down straight away.
Press the shutter button halfway down.
AE/AF lock indicator flashing → lit/beeps
Then press the shutter button fully down.

If the image looks blurred even after focusing, it may be because of camera shake. → See “Hints for preventing blur” (below).

Hints for preventing blur
Hold the camera steadily, keeping your arms at your side. Also, you can stabilize the camera by leaning against a tree or a building beside you. Using a tripod, and using the flash in dark places are also recommended.
Exposure Adjusting the light intensity

You can create various images by adjusting the exposure and the ISO sensitivity. Exposure is the amount of light that the camera will receive when you release the shutter.

Exposure:

- **Shutter speed** = Length of time the camera receives light
- **Aperture** = Size of the opening allowing light to pass through
- **ISO** = Recording sensitivity

**Overexposure**
- = too much light
- Whitish image

The exposure is automatically set to the proper value in the auto adjustment mode. However, you can adjust it manually using the functions below.

**[EV]:**
- Allows you to adjust the exposure that has been determined by the camera. → page 28

**Correct exposure**

**Underexposure**
- = too little light
- Darker image

**[Metering Mode]:**
- Allows you to change the part of the subject to be measured to determine the exposure. → page 28
Adjusting the ISO sensitivity

ISO is unit of measurement (sensitivity), estimating how much light an image pickup device (equivalent to photo films) receives. Even when the exposure is the same, images differ depending on the ISO sensitivity.

[ISO] adjusts the sensitivity → page 29

High ISO sensitivity
Records a bright image even when shooting in a dark location. However, the image tends to become noisy.

Low ISO sensitivity
Records a smoother image. However, the image may become darker.

Color

On the effects of lighting

The apparent color of the subject is affected by the lighting conditions.

Example: The color of an image affected by light sources

<table>
<thead>
<tr>
<th>Weather/lighting</th>
<th>Daylight</th>
<th>Cloudy</th>
<th>Fluorescent</th>
<th>Incandescent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristics of light</td>
<td>White (standard)</td>
<td>Bluish</td>
<td>Blue-tinged</td>
<td>reddish</td>
</tr>
</tbody>
</table>

The color tones are adjusted automatically in the auto adjustment mode. However, you can adjust color tones manually with [White Bal] (page 29).
A digital image is made up of a collection of small dots called pixels. If it contains a large number of pixels, the picture becomes large, it takes up more memory, and the image is displayed in fine detail. “Image size” is shown by the number of pixels. Although you cannot see the differences on the screen of the camera, the fine detail and data processing time differ when the image is printed or displayed on a computer screen.

Description of the pixels and the image size

1. Image size: 5M  
   2,592 pixels × 1,944 pixels = 5,038,848 pixels

2. Image size: VGA (E-Mail)  
   640 pixels × 480 pixels = 307,200 pixels
Selecting the image size for use

The default settings are marked with ✔.

<table>
<thead>
<tr>
<th>Image size</th>
<th>Usage guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ 5M (2592×1944)</td>
<td>Larger For printing in A4 size or high density images in A5 size</td>
</tr>
<tr>
<td>3:2 (2592×1728)</td>
<td>For printing in postcard size</td>
</tr>
<tr>
<td>3M (2048×1536)</td>
<td>For recording a large number of images</td>
</tr>
<tr>
<td>1M (1280×960)</td>
<td>For attaching images to e-mail or creating web pages</td>
</tr>
<tr>
<td>VGA (E-Mail) (640×480)</td>
<td>Smaller For recording a large number of images</td>
</tr>
</tbody>
</table>

* Images are recorded in the same 3:2 aspect ratio as photograph printing paper or postcards, etc.

Selecting the image quality (compression ratio) in combination (page 29)

You can select the compression ratio when digital images are saved. When you select a high compression ratio, the image lacks the fineness of detail, but has a smaller file size.
Identifying parts

See the pages in parentheses for details of operation.

1 Shutter button
2 Mode dial (24)
3 Microphone
4 Lens
5 POWER button / lamp
6 Flash
7 Self-timer lamp
8 Buzzer
9 USB jack
10 A/V OUT jack
11 Tripod receptacle
   • Use a tripod with a screw length of less than 5.5mm (7/32 inch). You will be unable to firmly secure the camera to tripods having screws longer than 5.5mm (7/32 inch), and may damage the camera.
12 Battery/“Memory Stick Duo” cover

13 AC Adaptor cord cover
   To use the AC-LS5K AC Adaptor (not supplied)

Do not pinch the cord when you close the cover.
14 LCD screen (20)
15 For shooting: Zoom (W/T) button
   For viewing: (Playback zoom)
   button/ (Index) button
16 Screen status button (20)
17 Hook for wrist strap
18 MENU button (26)
19 Control button
   Menu on: 
   Menu off: 
20 Access lamp
21 / (Image Size/Delete) button
Indicators on the screen

See the pages in parentheses for details of operation.

When shooting still images

1. Display Indication
   - Battery remaining
   - AE/AF lock
   - Recording mode (24, 30)
   - White balance (29)
   - Standby/Recording a movie

2. Display Indication
   - Mode dial (Scene Selection)
   - Mode dial (24)
   - Flash mode
   - Flash charging
   - Red-eye reduction (39)
   - Sharpness (31)
   - Saturation (31)
   - Metering mode (28)
   - Picture effect (30)

When shooting movies

1. Display Indication
   - Macro

2. Display Indication
   - Macro
### Display Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>3:2</td>
<td>3M 1M VGA</td>
</tr>
<tr>
<td>FINE STD</td>
<td>Image size</td>
</tr>
<tr>
<td></td>
<td>Recording folder (41)</td>
</tr>
<tr>
<td></td>
<td>• This does not appear when using the internal memory.</td>
</tr>
<tr>
<td></td>
<td>Remaining internal memory capacity (21)</td>
</tr>
<tr>
<td></td>
<td>Remaining “Memory Stick Duo” capacity (21)</td>
</tr>
<tr>
<td></td>
<td>Recording time [maximum recordable time] (21)</td>
</tr>
<tr>
<td></td>
<td>Remaining number of recordable images (21)</td>
</tr>
<tr>
<td></td>
<td>Self-timer</td>
</tr>
<tr>
<td>DATE</td>
<td>Date/Time (39)</td>
</tr>
<tr>
<td>iso400</td>
<td>ISO number (29)</td>
</tr>
</tbody>
</table>

### Display Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>❌</td>
<td>Low battery warning (23, 81)</td>
</tr>
<tr>
<td>+</td>
<td>Spot metering cross hair (28)</td>
</tr>
<tr>
<td>:</td>
<td>AF range finder frame (9)</td>
</tr>
</tbody>
</table>

### Display Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>Shutter speed</td>
</tr>
<tr>
<td>F2.8</td>
<td>Aperture value</td>
</tr>
<tr>
<td>+2.0EV</td>
<td>EV level value (28)</td>
</tr>
<tr>
<td>📧:</td>
<td>Menu / Guide Menu (26)</td>
</tr>
</tbody>
</table>

(not displayed on the screen on the previous page)
### When playing back still images

**Display** | **Indication**  
--- | ---  
[ ] | Battery remaining  
[ ] | Image size  
[ ] | Recording mode (24, 30)  
[ ] | Playback  
[ ] | Protect (33)  
[ ] | Print order (DPOF) mark (66)  
[ ] | Change folder (32)  
*This does not appear when using the internal memory.*

### When playing back movies

**Display** | **Indication**  
--- | ---  
[ ] | PictBridge connecting (63)  
[ ] | Recording folder (41)  
*This does not appear when using the internal memory.*  
[ ] | Playback folder (32)  
*This does not appear when using the internal memory.*  
[ ] | Remaining internal memory capacity (21)  
[ ] | Remaining “Memory Stick Duo” capacity (21)  
[ ] | Image number/Number of images recorded in selected folder  
[ ] | Counter
### Display Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>☞☐</td>
<td>Do not disconnect the USB cable (65)</td>
</tr>
<tr>
<td>+2.0EV</td>
<td>EV level value (28)</td>
</tr>
<tr>
<td>ISO400</td>
<td>ISO number (29)</td>
</tr>
<tr>
<td></td>
<td>Metering mode (28)</td>
</tr>
<tr>
<td></td>
<td>Flash</td>
</tr>
<tr>
<td></td>
<td>White balance (29)</td>
</tr>
<tr>
<td>33</td>
<td>Shutter speed</td>
</tr>
<tr>
<td>F2.8</td>
<td>Aperture value</td>
</tr>
<tr>
<td></td>
<td>Playback image</td>
</tr>
</tbody>
</table>

### Display Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006 1 1</td>
<td>Recording date/time of the playback image</td>
</tr>
<tr>
<td>⬅️ BACK/ NEXT</td>
<td>Select images</td>
</tr>
</tbody>
</table>
Changing the screen display

Each time you press the Screen status button, the display changes as follows.

- Indicators off
- Indicators on
Number of still images and recording time of movies

The tables show the approximate number of still images and the length of time for movies that can be recorded on a “Memory Stick Duo” and internal memory (10 MB) formatted with this camera. The values may vary depending on the shooting conditions.

**The number of still images (The image quality is [Fine] on the upper line and [Standard] on the lower line.)**

<table>
<thead>
<tr>
<th>Size</th>
<th>Capacity</th>
<th>Internal Memory</th>
<th>32MB</th>
<th>64MB</th>
<th>128MB</th>
<th>256MB</th>
<th>512MB</th>
<th>1GB</th>
<th>2GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>5M</td>
<td></td>
<td></td>
<td>3</td>
<td>12</td>
<td>24</td>
<td>50</td>
<td>96</td>
<td>191</td>
<td>391</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7</td>
<td>23</td>
<td>46</td>
<td>95</td>
<td>182</td>
<td>360</td>
<td>736</td>
</tr>
<tr>
<td>3:2</td>
<td></td>
<td></td>
<td>3</td>
<td>12</td>
<td>24</td>
<td>50</td>
<td>96</td>
<td>191</td>
<td>391</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7</td>
<td>23</td>
<td>46</td>
<td>95</td>
<td>182</td>
<td>360</td>
<td>736</td>
</tr>
<tr>
<td>3M</td>
<td></td>
<td></td>
<td>6</td>
<td>19</td>
<td>39</td>
<td>81</td>
<td>155</td>
<td>308</td>
<td>629</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>11</td>
<td>35</td>
<td>72</td>
<td>148</td>
<td>283</td>
<td>560</td>
<td>1143</td>
</tr>
<tr>
<td>1M</td>
<td></td>
<td></td>
<td>15</td>
<td>48</td>
<td>98</td>
<td>201</td>
<td>384</td>
<td>759</td>
<td>1550</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>28</td>
<td>91</td>
<td>184</td>
<td>375</td>
<td>715</td>
<td>1414</td>
<td>2886</td>
</tr>
<tr>
<td>VGA(E-Mail)</td>
<td></td>
<td></td>
<td>60</td>
<td>191</td>
<td>387</td>
<td>789</td>
<td>1503</td>
<td>2972</td>
<td>6065</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>147</td>
<td>463</td>
<td>935</td>
<td>1879</td>
<td>3630</td>
<td>7167</td>
<td>14643</td>
</tr>
</tbody>
</table>

- The number of images listed is for when [Mode] is set to [Normal].
- When the number of remaining shootable images is greater than 9,999, the “>9999” indicator appears.
- You can resize the images later ([Resize], (page 35)).

**The recording time of movies (hour : minute : second)**

<table>
<thead>
<tr>
<th>Size</th>
<th>Capacity</th>
<th>Internal Memory</th>
<th>32MB</th>
<th>64MB</th>
<th>128MB</th>
<th>256MB</th>
<th>512MB</th>
<th>1GB</th>
<th>2GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>320×240</td>
<td></td>
<td></td>
<td>0:00:30</td>
<td>0:01:37</td>
<td>0:03:17</td>
<td>0:06:38</td>
<td>0:12:50</td>
<td>0:25:24</td>
<td>0:51:50</td>
</tr>
</tbody>
</table>

- For image size and image quality, see page 12.
- When images recorded using earlier Sony models are played back on this camera, the display may differ from the actual image size.
When you do not have a “Memory Stick Duo”  
(Recording with the internal memory)

The camera has 10 MB of internal memory. This memory is not removable. Even when there is no “Memory Stick Duo” inserted in the camera, you can record images using this internal memory.

When a “Memory Stick Duo” (not supplied) is inserted

[Recording]: Images are recorded on the “Memory Stick Duo”.
[Playback]: Images on the “Memory Stick Duo” are played back.
[Menu, Setup, etc.]: Various functions can be performed on images on the “Memory Stick Duo”.

When there is no “Memory Stick Duo” inserted

[Recording]: Images are recorded using the internal memory.
[Playback]: Images stored in the internal memory are played back.
[Menu, Setup, etc.]: Various functions can be performed on images in the internal memory.

On image data stored in the internal memory

We recommend that you copy (back up) data without fail using one of the following methods.

To copy (back up) data on a “Memory Stick Duo”

Prepare a “Memory Stick Duo” with a capacity of 16 MB or more, then perform the procedure explained in [Copy] (page 42).

To copy (back up) data on a hard disc of your computer

Perform the procedure on pages 49 to 51 without a “Memory Stick Duo” inserted in the camera.

- You cannot move image data on a “Memory Stick Duo” to the internal memory.
- By connecting the camera and a computer with a USB cable, you can copy data stored in the internal memory to a computer, but you cannot copy data on a computer to the internal memory.
Battery life and number of images that can be recorded/viewed

The tables show the approximate number of images that can be recorded/viewed and the battery life when you shoot images in [Normal] mode with batteries at full capacity and at an ambient temperature of 25°C (77°F). The numbers of images that can be recorded or viewed take into account changing the “Memory Stick Duo” as necessary.

Note that the actual numbers may be less than those indicated depending on the conditions of use.

- The battery capacity decreases as the number of uses increases and also over time (page 85).
- The number of images that can be recorded/viewed and the battery life are decreased under the following conditions:
  - The surrounding temperature is low
  - The flash is used
  - The camera has been turned on and off many times
  - The zoom is used frequently
  - [LCD Backlight] is set to [Bright]
  - The battery power is low

When shooting still images

<table>
<thead>
<tr>
<th>Battery</th>
<th>No. of images (Approx.)</th>
<th>Battery life (min.) (Approx.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alkaline</td>
<td>90</td>
<td>45</td>
</tr>
<tr>
<td>NH-AA-DB (Ni-MH)</td>
<td>350</td>
<td>170</td>
</tr>
</tbody>
</table>

- Shooting in the following situations:
  - (P.Quality) is set to [Fine]
  - Shooting once every 30 seconds
  - The zoom is switched alternately between the W and T ends
  - The flash strobes once every two times
  - The power turns on and off once every ten times
- The measurement method is based on the CIPA standard.
  (CIPA: Camera & Imaging Products Association)
- Number of shooting images/battery life does not change depending on the image size.

When viewing still images

<table>
<thead>
<tr>
<th>Battery</th>
<th>No. of images (Approx.)</th>
<th>Battery life (min.) (Approx.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alkaline</td>
<td>1800</td>
<td>90</td>
</tr>
<tr>
<td>NH-AA-DB (Ni-MH)</td>
<td>4800</td>
<td>240</td>
</tr>
</tbody>
</table>

- Viewing single images in order at about three second intervals

When shooting movies

<table>
<thead>
<tr>
<th>Battery</th>
<th>Battery life (min.) (Approx.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alkaline</td>
<td>40</td>
</tr>
<tr>
<td>NH-AA-DB (Ni-MH)</td>
<td>120</td>
</tr>
</tbody>
</table>

- Shooting movies continuously with an image size of [320]
Using the mode dial

Set the mode dial to the desired function.

Still image shooting modes

Auto adjustment mode
Allows easy shooting with the settings adjusted automatically.

Scene Selection mode
Allows you to shoot with preset settings according to the scene.

Program auto shooting mode
Allows you to shoot with the exposure adjusted automatically (both the shutter speed and the aperture value). Also you can select various settings using the menu.
(For details on the functions available → page 27)

In this Cyber-shot Handbook, the available mode dial setting is shown as follows.
Scene Selection
For shooting an image appropriately according to the scene condition, a combination of functions is determined by the camera.

(✓: you can select the desired setting)

<table>
<thead>
<tr>
<th>Macro</th>
<th>Flash</th>
<th>White Balance</th>
<th>Burst</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>—</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>$SL$</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>$\odot$</td>
<td>☀</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>$$/\odot$</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>$$/\odot$</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
1 Turn on the power and set the mode dial.
   Items available vary depending on the mode dial position.

2 Press MENU to display the menu.

3 Select the desired menu item with ◀/▶ on the control button.
   • If the desired item is invisible, keep pressing ◀/▶ until it appears on the screen.
   • Press ◎ after selecting an item when the mode dial is set to ◄.

4 Select the setting with ▲/▼.
   The setting you select is zoomed and is set.

5 Press MENU to turn off the menu.

• If there is an item that is not displayed, an ▲/▼ mark appears on the edges of the location where menu items usually appear. To display an item that is not displayed, select the mark with the control button.
• You cannot select items that are grayed out.
Menu items

The menu items available vary depending on the mode dial position. Only the available items are displayed on the screen.

<table>
<thead>
<tr>
<th>Mode dial position:</th>
<th></th>
<th>P</th>
<th>Scene</th>
<th></th>
<th></th>
</tr>
</thead>
</table>

**Menu for shooting** (page 28)

<table>
<thead>
<tr>
<th>Item</th>
<th>📷 (EV)</th>
<th>—</th>
<th>✓</th>
<th>✓</th>
<th>✓</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>📷 (Metering Mode)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>WB (White Bal)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>ISO</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>🔈: (P.Quality)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Mode (REC Mode)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>PFX (P.Effect)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>🍎 (Saturation)</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>🍎 (Sharpness)</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>🚫 (Setup)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

**Menu for viewing** (page 32)

<table>
<thead>
<tr>
<th>Item</th>
<th>—</th>
<th>—</th>
<th>—</th>
<th>—</th>
<th>✓</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>📷 (Folder)</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>🔧 (Protect)</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>DPOF</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>🌸 (Print)</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>🎉 (Slide)</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>🛠️ (Resize)</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>🌠 (Rotate)</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>🚫 (Setup)</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
</tbody>
</table>

* The operation is limited according to the Scene mode (page 25).
For details on the operation → page 26

The default settings are marked with ✔️.

### (EV)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>+2.0EV</td>
<td>Toward +: Brightens an image.</td>
</tr>
<tr>
<td>✔️ 0EV</td>
<td>The exposure is determined automatically by the camera.</td>
</tr>
<tr>
<td>−2.0EV</td>
<td>Toward −: Darkens an image.</td>
</tr>
</tbody>
</table>

- For details on the exposure → page 10
- The compensation value can be set in 1/3EV increments.
- If a subject is being shot in extremely bright or dark conditions, or the flash is used, the exposure adjustment may not be effective.

### (Metering Mode)

Selects the metering mode that sets which part of the subject to measure to determine the exposure.

<table>
<thead>
<tr>
<th></th>
<th>Measures only a part of the subject.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spot (Spot metering)</td>
<td>• This function is useful when the subject is backlit or when there is strong contrast between the subject and the background.</td>
</tr>
<tr>
<td>(Spot metering)</td>
<td>Spot metering cross hair Positions on the subject.</td>
</tr>
</tbody>
</table>

- For details on the exposure → page 10
Adjusts the color tones according to the lighting condition in a situation, for example, when the colors of a image look strange.

<table>
<thead>
<tr>
<th>WB (White Bal)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Incandescent)</td>
<td>Adjusts for places where the lighting conditions change quickly such as a party hall, or under bright lighting such as photography studios.</td>
</tr>
<tr>
<td>(Fluorescent)</td>
<td>Adjusts for fluorescent lighting.</td>
</tr>
<tr>
<td>(Cloudy)</td>
<td>Adjusts for a cloudy sky.</td>
</tr>
<tr>
<td>(Daylight)</td>
<td>Adjusts for outdoors, shooting night scenes, neon signs, fireworks, or sunrise, or conditions before and after sundown.</td>
</tr>
<tr>
<td>Auto</td>
<td>Adjusts the White Balance automatically.</td>
</tr>
</tbody>
</table>

- For details on [WB] → page 11
- Under fluorescent lights that flicker, the white balance function may not work correctly even though you select (Fluorescent).

Selects a luminous sensitivity with units of ISO. The larger the number, the higher the sensitivity.

<table>
<thead>
<tr>
<th>ISO</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>400</td>
<td>Select a large number when shooting in dark locations or shooting a subject moving at high speed, or select a small number to obtain high image quality.</td>
</tr>
<tr>
<td>200</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
</tr>
<tr>
<td>Auto</td>
<td></td>
</tr>
</tbody>
</table>

- For details on the [ISO] sensitivity → page 11
- Note that the image tends to become noisier as the ISO sensitivity number increases.
- [ISO] is set to [Auto] in the Scene mode.

Selects the still image quality.

<table>
<thead>
<tr>
<th>(P.Quality)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fine (FINE)</td>
<td>Records with high quality (low compression).</td>
</tr>
<tr>
<td>Standard (STD)</td>
<td>Records with standard quality (high compression).</td>
</tr>
</tbody>
</table>

- For details on the image quality → page 12
For details on the operation → page 26

Mode (REC Mode)

Selects whether the camera performs continuous shooting or not when you press the shutter button.

| Burst ( Burst) | Records the maximum number of images in succession (refer to the following table) when you press and hold down the shutter button. • When “Recording” disappears, you can shoot the next image. |
| Normal | Does not shoot continuously. |

On the [Burst]
• The flash is set to (No flash).
• When recording with the self timer, a series of a maximum of three images is recorded.
• When the battery level is low, or when the internal memory or “Memory Stick Duo” is full, the [Burst] stops.
• You may not be able to shoot images in the [Burst] mode depending on the Scene mode (page 25).

The maximum number of continuous shots
(Units: images)

<table>
<thead>
<tr>
<th>Size</th>
<th>Quality</th>
<th>Fine</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>5M</td>
<td>Fine</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>3:2</td>
<td>Fine</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>3M</td>
<td>Fine</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>1M</td>
<td>Fine</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>VGA(E-Mail)</td>
<td>Fine</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

PFX (P.Effect)

Allows you to shoot an image with special effects.

| B & W (P+) | Records the image in monochrome (black and white). |
| Sepia (P+) | Records the image in sepia (like an old photograph). |
| Off | No effect. |
Using the menu

For details on the operation → page 26

**° (Saturation)**

Adjusts the saturation of the image.

<table>
<thead>
<tr>
<th>+ ( )</th>
<th>Toward +: Brightens the color.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Normal</td>
<td></td>
</tr>
<tr>
<td>− ( )</td>
<td>Toward −: Darkens the color.</td>
</tr>
</tbody>
</table>

**هى (Sharpness)**

Adjusts the sharpness of the image.

<table>
<thead>
<tr>
<th>+ ( )</th>
<th>Toward +: Sharpens the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Normal</td>
<td></td>
</tr>
<tr>
<td>− ( )</td>
<td>Toward −: Softens the image.</td>
</tr>
</tbody>
</table>

** COMMENTS**

See page 37.
Viewing menu

The default settings are marked with ✔.

Selects the folder containing the image you want to play back when using a “Memory Stick Duo”.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Cancel</td>
<td>Cancels the selection.</td>
</tr>
</tbody>
</table>

1. Select the desired folder with ◀/▶ on the control button.

2. Select [OK] with ▲, then press ●.

On the [Folder]
The camera stores images in a specified folder of a “Memory Stick Duo” (page 41). You can change the folder or create a new one.

- To create a new folder → [Create REC. Folder] (page 41)
- To change the folder for recording images → [Change REC. Folder] (page 42)
- When multiple folders are created in the “Memory Stick Duo” and the first or last image in the folder is displayed, the following indicators appear.

- ◄: Moves to the previous folder.
- ►: Moves to the next folder.
- ◀/▶: Moves to either the previous and next folders.
Protects images against accidental erasure.

| protect (Protect) | See the following procedure. |
| Exit              | Exits the Protection function. |

**To protect images in single-image mode**

1. Display the image you want to protect.
2. Press MENU to display the menu.
3. Select [ ] (Protect) with on the control button, then press .
   The image is protected and the (protect) indicator appears on the image.

4. To protect other images, select the desired image with , then press .

**To protect images in index mode**

1. Press (index) to display the index screen.
2. Press MENU to display the menu.
3. Select [ ] (Protect) with on the control button, then press .
4. Select [Select] with , then press .
5. Select the image you want to protect with , then press .
   A green indicator appears on the selected image.

6. Repeat step 5 to protect other images.
7. Press MENU.
8. Select [OK] with , then press .
   The indicator turns white. The selected images are protected.

- To protect all images in the folder, select [All In This Folder] in step 4, and press . Select [On] with , then press .
To cancel the protection

In single-image mode
Press ● in step 3 or 4 of “To protect images in single-image mode.”

In index mode
① Select the image for which you want to remove protection in step 5 of “To protect images in index mode.”
② Press ● to turn the ○ indicator gray.
③ Repeat the operation above for all images to be unprotected.
④ Press MENU, select [OK] with ▲, and then press ●.

To cancel protection of all images in the folder
Select [All In This Folder] in step 4 of “To protect images in index mode,” and press ●. Select [Off] with ▲, then press ●.

- Note that formatting the internal memory or “Memory Stick Duo” erases all the data stored on the recording media, even if images are protected, and these images cannot be recovered.
- It may take some time to protect an image.

DPOF

Adds a (Print order) mark to images you want to print (page 66).

(Print)

See page 63.

(Slide)

Plays back recorded images in order (Slide show).

Interval

<table>
<thead>
<tr>
<th>✔ 3 sec</th>
<th>Sets the slide show interval.</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 sec</td>
<td></td>
</tr>
<tr>
<td>10 sec</td>
<td></td>
</tr>
<tr>
<td>30 sec</td>
<td></td>
</tr>
<tr>
<td>1 min</td>
<td></td>
</tr>
</tbody>
</table>
Using the menu

For details on the operation → page 26

Image

<table>
<thead>
<tr>
<th>✔️ Folder</th>
<th>Plays back all images in the selected folder.</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Plays back all images stored on the “Memory Stick Duo”.</td>
</tr>
</tbody>
</table>

Repeat

| ✔️ On | Plays back images in a continuous loop. |
| Off | After all the images have been played back, the slide show ends. |

Start

See the following procedure.

✔️ Cancel

Cancels the slide show.

1. Select [Interval], [Image] and [Repeat] with ▲▼◄► on the control button.
2. Select [Start] with ▼►, then press ●.

To end the slide show, press ●, select [Exit] with ►, then press ●.

- During a slide show, you can display the previous/next image with ◄►.
- The [Interval] time is just a guideline, so it may vary depending on the image size, etc.

![Resize]

You can change the image size of a recorded image (Resize), and save it as a new file. The original image is retained even after resizing.

<table>
<thead>
<tr>
<th>5M</th>
<th>The setting size is just a guideline. (see page 13)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3M</td>
<td></td>
</tr>
<tr>
<td>1M</td>
<td></td>
</tr>
<tr>
<td>VGA</td>
<td></td>
</tr>
<tr>
<td>✔️ Cancel</td>
<td>Cancels resizing.</td>
</tr>
</tbody>
</table>

1. Display the image you want to resize.
2. Press MENU to display the menu.
3. Select [ ] (Resize) with ◄►, then press ●.
4. Select the desired size with ▲▼, then press ●.

The resized image is recorded in the recording folder as the newest file.

- For details on [Image Size], see page 13.
- When you change from a small size to a large size, the image quality deteriorates.
- You can not resize the image size to [3:2].
Rotates a still image.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Rotate]</td>
<td>![OK]</td>
</tr>
<tr>
<td>![Cancel]</td>
<td>![Setup]</td>
</tr>
</tbody>
</table>

1. Display the image to be rotated.
2. Press MENU to display the menu.
3. Select [.Rotate] (Rotate) with ▲/▼ on the control button, then press ●.
4. Select [▲/▼] with ▲, then rotate the image with ▲/▼.
5. Select [OK] with ▲/▼, then press ●.

- You may not be able to rotate images shot with other cameras.
- When viewing images on a computer, the image rotation information may not be reflected depending on the software.

See page 37.
Using the Setup screen

Using Setup items

You can change the default settings using the Setup screen.

1. Turn on the power.

2. Press MENU to display the menu.

3. After pressing ▶ on the control button, go to the (Setup) setting, then press ▶ again.

4. Press ▲/▼/◄/► on the control button to select the item you want to set.

   The frame of the selected item turns yellow.

5. Press ● to enter the setting.

To turn off the (Setup) screen, press MENU.
To return to the menu from the (Setup) screen, press ◄ on the control button repeatedly.

To cancel the (Setup) setting

Select [Cancel] if it appears, then press ● on the control button. If it does not appear, select the previous setting again.

• This setting is maintained even when the power is turned off.
The default settings are marked with ☑.

**Digital Zoom**

Selects the digital zoom mode. The camera enlarges the image using optical zoom (up to 3×). When the zoom scale exceeds 3×, the camera uses either smart or precision digital zoom.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| ☑ Smart (Smart zoom)        | Enlarges the image digitally with almost no distortion. This is not available when the image size is set to [5M] or [3:2].  
  * The maximum zoom scale of Smart zoom is shown in the following table. |
| Precision (Precision digital zoom) | Enlarges all image sizes up to a maximum of 6×, but the image quality deteriorates. |
| Off (×)                     | Does not use the digital zoom.                                               |

**Image size and maximum zoom scale using Smart zoom**

<table>
<thead>
<tr>
<th>Size</th>
<th>Maximum zoom scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>3M</td>
<td>Approx. 3.7</td>
</tr>
<tr>
<td>1M</td>
<td>Approx. 6.0</td>
</tr>
<tr>
<td>VGA(E-Mail)</td>
<td>Approx. 12.0</td>
</tr>
</tbody>
</table>

- When you press the zoom button, the zoom scaling indicator appears as follows.

  ![Zoom scaling indicator diagram](image)

  * The W side of this line is the optical zoom area, and the T side is the digital zoom area.
  * The maximum zoom scale of smart zoom/precision zoom includes the scale of the optical zoom.
  * When using the smart zoom, the image on the screen may look rough. However, this phenomenon has no effect on the recorded image.
Using the Setup screen

For details on the operation → page 37

---

**Date/Time**

Selects how to superimpose the date or time onto the image. Select this before shooting.

- The date and time do not appear during shooting, instead, the **DATE** indicator appears. The date and time appear in red on the lower-right corner of the screen during playback only.

<table>
<thead>
<tr>
<th>Day&amp;Time</th>
<th>Superimposes the date, hour, and minute.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Superimposes the year, month and day.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not superimpose the date and time.</td>
</tr>
</tbody>
</table>

- You cannot insert the data and time into movies.
- The date and time superimposed cannot be removed later.

---

**Red Eye Reduction**

Reduces the red-eye phenomenon when using the flash. Select this before shooting.

<table>
<thead>
<tr>
<th>On ( )</th>
<th>Reduces the red-eye phenomenon.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not use Red Eye Reduction.</td>
</tr>
</tbody>
</table>

- The flash pre-strobes twice or more before shooting.

- Because it takes about a second until the shutter clicks, hold the camera firmly to prevent the effects of vibration. Also, do not let the subject move.
- Red-eye reduction may not produce the desired effects depending on individual differences, the distance to the subject, if the subject does not see the pre-strobe, or other conditions.

---

**Auto Review**

Displays the recorded image on the screen for approximately two seconds immediately after shooting a still image.

<table>
<thead>
<tr>
<th>On</th>
<th>Use the Auto Review.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not use Auto Review.</td>
</tr>
</tbody>
</table>

- You cannot shoot the next image during the Auto Review display. If you press the shutter button halfway down during this period, the recorded image display disappears and you can immediately shoot the next image.
This item does not appear when a “Memory Stick Duo” is inserted in the camera.
The default settings are marked with ✔.

### Format

Formats the internal memory.
- Note that formatting irrevocably erases all data in the internal memory, including even protected images.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Cancel</td>
<td>Cancels the formatting.</td>
</tr>
</tbody>
</table>

1. Select [OK] with ▲ on the control button, then press ●.
   The message “All data in internal memory will be erased Ready?” appears.
2. Select [OK] with ▲, then press ●.
   The format is complete.
This item appears only when a “Memory Stick Duo” is inserted in the camera. The default settings are marked with ✓.

### Format

Formats the “Memory Stick Duo”. A commercially available “Memory Stick Duo” is already formatted, and can be used immediately.

- Note that formatting irrevocably erases all data on a “Memory Stick Duo”, including even protected images.

| OK | See the following procedure. |
| ✓ Cancel | Cancels the formatting. |

1. Select [OK] with ▲ on the control button, then press ●.
   The message “All data in Memory Stick will be erased Ready?” appears.

2. Select [OK] with ▲, then press ●.
   The format is complete.

### Create REC. Folder

Creates a folder in a “Memory Stick Duo” for recording images.

| OK | See the following procedure. |
| ✓ Cancel | Cancels folder creation. |

1. Select [OK] with ▲ on the control button, then press ●.
   The folder creation screen appears.

2. Select [OK] with ▲, then press ●.
   A new folder is created with a number incremented one higher than the largest number, and the folder becomes the current recording folder.

- For details on the folder, see page 32.
- When not creating a new folder, the “101MSDCF” folder is selected as the recording folder.
- You can create folders designated up to “999MSDCF.”
- Images are recorded in the newly created folder until a different folder is created or selected.
- You cannot delete a folder with the camera. To delete a folder, use your computer, etc.
- Up to 4,000 images can be stored in one folder. When the folder capacity is exceeded, a new folder is automatically created.
- For more information, see “Image file storage destinations and file names” (page 54).
Change REC. Folder

Changes the folder currently used for recording images.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Cancel</td>
<td>Cancels changing the recording folder.</td>
</tr>
</tbody>
</table>

1. Select [OK] with ▲ on the control button, then press ●.
   The folder selection screen appears.

2. Select the desired folder with ◀/▶, and [OK] with ▲, then ●.
   - You cannot select the “100MSDCF” folder as a recording folder.
   - You cannot move recorded images to a different folder.

Copy

Copies all images in the internal memory to a “Memory Stick Duo”.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Cancel</td>
<td>Cancels the copying.</td>
</tr>
</tbody>
</table>

1. Insert a “Memory Stick Duo” having 16 MB or larger capacity.

2. Select [OK] with ▲ on the control button, then press ●.
   The message “All data in internal memory will be copied Ready?” appears.

3. Select [OK] with ▲, then press ●.
   Copying starts.

   - Use batteries with enough capacity or the AC Adaptor (not supplied). If you attempt to copy image files using batteries with little remaining charge, the batteries may run out, causing copying to fail or possibly corrupting the data.
   - You cannot copy individual images.
   - The original images in the internal memory are retained even after copying. To delete the contents of the internal memory, remove the “Memory Stick Duo” after copying, then execute the [Format] command in Internal Memory Tool (page 40).
   - You cannot select a folder copied on a “Memory Stick Duo”.
   - The setting of (Print order) marks is not copied even when you copy data.
The default settings are marked with ✓.

### LCD Backlight

Selects the brightness of the LCD backlight when using the camera with batteries.

<table>
<thead>
<tr>
<th>Bright</th>
<th>Brightens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Normal</td>
<td></td>
</tr>
</tbody>
</table>

- Selecting [Bright] uses up the battery charge faster.

### Beep

Selects the sound produced when you operate the camera.

<table>
<thead>
<tr>
<th>Shutter</th>
<th>Turns on the shutter sound when you press the shutter button.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ On</td>
<td>Turns on the beep/shutter sound when you press the control button/ press the shutter button.</td>
</tr>
<tr>
<td>Off</td>
<td>Turns off the beep/shutter sound.</td>
</tr>
</tbody>
</table>

### Initialize

Initializes the setting to the default setting.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Cancel</td>
<td>Cancels the resetting.</td>
</tr>
</tbody>
</table>

1. Select [OK] with ▲ on the control button, then press ●. The message “Initialize all settings Ready?” appears.
2. Select [OK] with ▲, then press ●. The settings are reset to the default setting.

- Make sure that the power is not disconnected during resetting.
The default settings are marked with ☑.

## File Number

Selects the method used to assign file numbers to images.

<table>
<thead>
<tr>
<th>☑ Series</th>
<th>Assigns numbers to files in sequence even if the recording folder or the “Memory Stick Duo” is changed. (When the replaced “Memory Stick Duo” contains a file with a number higher than the last assigned number, a number one higher than the largest number is assigned.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
<td>Starts from 0001 each time the folder is changed. (When the recording folder contains a file, a number one higher than the largest number is assigned.)</td>
</tr>
</tbody>
</table>

## USB Connect

Selects the USB mode to be used when connecting the camera to a computer or a PictBridge compliant printer using the USB cable.

<table>
<thead>
<tr>
<th>PictBridge</th>
<th>Connects the camera to a PictBridge compliant printer (page 63).</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ Normal</td>
<td>Connects the camera to a computer.</td>
</tr>
</tbody>
</table>

## Video Out

Sets the video signal output according to the TV color system of the connected video equipment. Different countries and regions use different TV color systems. If you want to view images on a TV screen, check page 69 for the TV color system of the country or region where the camera is used.

<table>
<thead>
<tr>
<th>NTSC</th>
<th>Sets the video output signal to NTSC mode (e.g., for the USA, Japan).</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAL</td>
<td>Sets the video output signal to PAL mode (e.g., for Europe).</td>
</tr>
</tbody>
</table>
Clock Set

Sets the date and time.

<table>
<thead>
<tr>
<th>OK</th>
<th>Select [OK] with ▲ on the control button, and press ●. Then, perform the procedure explained in “Set the clock”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ Cancel</td>
<td>Cancels setting the clock.</td>
</tr>
</tbody>
</table>
For details on using a Macintosh computer, refer to “Using your Macintosh computer” (page 60). This section describes the English version screen contents.

Install the software (supplied) first (page 48)

Copying images to your computer (page 49)

Viewing images saved on your computer

Enjoying images using the “Cyber-shot Viewer” (page 56)

• Viewing images saved on your computer
• Viewing photos organized by date
• Editing images

Printing images
Recommended computer environment

The following environment is recommended for a computer connected to the camera.

Recommended environment for copying images

  • Operation is not assured in an environment based on an upgrade of the operating systems described above or in a multi-boot environment.

USB jack: Provided as standard

Recommended environment for using the Cyber-shot Viewer


Sound card: 16-bit stereo sound card with speakers

Processor/Memory: Pentium III 500 MHz or faster, 128 MB of RAM or more (Recommended: Pentium III 800 MHz or faster and 256 MB of RAM or more)

Software: DirectX 9.0c or later

Hard Disk: Disk space required for installation—200 MB or more

Display: Screen resolution; 800 × 600 dots or more Colors; High Color (16-bit color, 65,000 colors) or more
  • This software is compatible with DirectX technology. DirectX must be installed for use.

Notes on connecting your camera to a computer

• Operations are not guaranteed for all the recommended computer environments mentioned above.

• If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate, depending on the types of USB devices you are using.

• Operations are not guaranteed when using a USB hub.

• The [Normal] (default setting) mode is for a USB connection when connecting a computer. This section describes the [Normal] mode as an example.

• When your computer resumes from a suspend or sleep mode, communication between your camera and your computer may not recover at the same time.
Installing the software (supplied)

You can install the software (supplied) using the following procedure.
- When using Windows 2000/Me, do not connect the camera to the computer before installation.
- In Windows 2000/XP, log on as Administrator.
- When the supplied software is installed, the USB driver is installed automatically.

1 Turn on your computer, and insert the CD-ROM (supplied) into the CD-ROM drive.
   The installation menu screen appears.
   • If it does not appear, double-click (My Computer) → (CYBERSHOTSOFT).

2 Click [Install].
   The “Choose Setup Language” screen appears.

3 Select the desired language, then click [Next].
   The “License Agreement” screen appears.
   Read the agreement carefully. If you accept the terms of the agreement, click the radio button next to [I accept the terms of the license agreement] and then click [Next].

4 Follow the instructions on the screen to complete the installation.
   • When the restarting confirmation message appears, restart the computer following the instructions on the screen.
   • DirectX will be installed if you have not yet installed them.

5 Remove the CD-ROM after the installation is complete.
Copy images to your computer

This section describes the process using a Windows computer as an example. You can copy images from the camera to your computer as follows.

For a computer with a “Memory Stick” slot
Remove the “Memory Stick Duo” from the camera and insert it in the Memory Stick Duo Adaptor (not supplied). Insert the Memory Stick Duo Adaptor (not supplied) in the computer and copy the images. If the “Memory Stick PRO Duo” is not recognized, see page 77.

For a computer without a “Memory Stick” slot
Follow Stages 1 through 4 on pages 49 to 53 to copy images.
- When using Windows 2000/Me, install the supplied software before proceeding. With Windows XP, the installation is unnecessary.
- The screen displays shown in this section are the examples for copying images from “Memory Stick Duo”.

Stage 1: Preparing the camera and the computer

1 Insert a “Memory Stick Duo” with recorded images into the camera.
   - When copying images in the internal memory, this step is unnecessary.

2 Insert the sufficiently charged battery pack in the camera, or connect the camera to a wall outlet (wall socket) with the AC Adaptor (not supplied).

3 Set the mode dial to , then press POWER to turn on the camera and the computer.

- When you copy images to your computer using a battery pack with little remaining charge, copying may fail or image data may become corrupted if the battery pack shuts down too soon.
Stage 2: Connecting the camera and your computer

With Windows XP, the AutoPlay wizard appears on the desktop.

"USB Mode Normal" appears on the screen of the camera.

Stage 3-A: Copying images to a computer

- For Windows 2000/Me, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 51.
- For Windows XP, when the wizard screen does not appear automatically, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 51.

This section describes an example of copying images to a “My Documents” folder.

1 After making a USB connection in Stage 2, click [Copy pictures to a folder on my computer using Microsoft Scanner and Camera Wizard] → [OK] as the wizard screen appears automatically on the desktop.

The “Scanner and Camera Wizard” screen appears.
2 Click [Next].

The images saved on the “Memory Stick Duo” of the camera appear.
• If no “Memory Stick Duo” is inserted, images in the internal memory appear.

3 Click the check box of unwanted images to remove the checkmark so they are not copied, then click [Next].

The “Picture Name and Destination” screen appears.

4 Select a name and destination for the images, then click [Next].

Image copying starts. When the copying is completed, the “Other Options” screen appears.
• This section describes an example of copying images to the “My Documents” folder.

5 Click the radio button next to [Nothing. I'm finished working with these pictures] to select it, then click [Next].

The “Completing the Scanner and Camera Wizard” screen appears.

6 Click [Finish].

The wizard screen closes.
• To continue copying other images, disconnect the USB cable. Then follow the procedure explained in “Stage 2: Connecting the camera and your computer” on page 50.

Stage 3-B: Copying images to a Computer

• For Windows XP, follow the procedure explained in “Stage 3-A: Copying images to a computer” on page 50.

This section describes an example of copying images to the “My Documents” folder.
1 Double-click [My Computer] → [Removable Disk] → [DCIM].

- If the “Removable Disk” icon is not displayed, see page 76.

2 Double-click the folder where the image files you want to copy are stored.
Then, right-click an image file to display the menu and click [Copy].

- On the storage destination of the image files, see page 54.

3 Double-click the [My Documents] folder. Then, right-click on the “My Documents” window to display the menu and click [Paste].

The image files are copied to the “My Documents” folder.
- When an image with the same file name exists in the copy destination folder, the overwrite confirmation message appears. When you overwrite an existing image with a new one, the original file data is deleted. To copy an image file to the computer without overwriting, change the file name to a different name and then copy the image file. However, note that if you change the file name (page 55), you may not be able to play back that image with your camera.
Stage 4: Viewing images on your computer

This section describes the procedure for viewing copied images in the “My Documents” folder.

1 Click [Start] → [My Documents].

The contents of the “My Documents” folder are displayed.

• If you are not using Windows XP, double-click [My Documents] on the desktop.

2 Double-click the desired image file.

The image is displayed.

To delete the USB connection

Perform the procedures listed below beforehand when:
• Disconnecting the USB cable
• Removing a “Memory Stick Duo”
• Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
• Turning off the camera

For Windows 2000/Me/XP

① Double-click on the tasktray.

Double-click here

② Click (Sony DSC) → [Stop].
③ Confirm the device on the confirmation window, then click [OK].
④ Click [OK].

The device is disconnected.

• Step 4 is unnecessary for Windows XP.
The image files recorded with your camera are grouped as folders on the “Memory Stick Duo”.

**Example: viewing folders on Windows XP**

- **Folder containing image data recorded using a camera not equipped with the folder creating function**
- **Folder containing image data recorded using this camera**
  
  When no new folders are created, there are folders as follows:
  - “Memory Stick Duo”; “101MSDCF” only
  - Internal memory; “101_SONY” only

- You cannot record any images to the “100MSDCF” folder. The images in these folders are available only for viewing.
- You cannot record/playback any images to the “MISC” folder.

- Image files are named as follows. □□□□ stands for any number within the range from 0001 to 9999. The numerical portions of the name of a movie file recorded in movie mode and its corresponding index image file are the same.
  - Still image files: DSC0□□□□.JPG
  - Movie files: MOV0□□□□.AVI
  - Index image files that are recorded when you record movies: MOV0□□□□.THM

- For more information about folders, see pages 32 and 41.
Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”)

This section describes the process using a Windows computer as an example. When an image file copied to a computer no longer remains on a “Memory Stick Duo”, you can view that image again on the camera by copying the image file on the computer to a “Memory Stick Duo”.

- Step 1 is not necessary if the file name set with your camera has not been changed.
- You may be unable to play back some images depending on the image size.
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- When there is no folder, first create a folder with your camera (page 41) and then copy the image file.

1 Right-click the image file, then click [Rename]. Change the file name to “DSC0□□□□.”

Enter a number from 0001 to 9999 for □□□□.

• If the overwrite confirmation message appears, enter a different number.
• An extension may be displayed depending on the computer settings. The extension for still images is JPG, and the extension for movies is AVI. Do not change the extension.

2 Copy the image file to the “Memory Stick Duo” folder in the following order.

① Right-click the image file, then click [Copy].
② Double-click [Removable Disk] or [Sony Memory Stick Duo] in [My Computer].
③ Right-click the [□□□□MSDCF] folder in the [DCIM] folder, then click [Paste].

- □□□□ stands for any number within the range from 100 to 999.
Using the “Cyber-shot Viewer” (supplied)

You can use still images and movies from the camera more than ever by taking advantage of the software. This section summarizes the “Cyber-shot Viewer” and gives basic instructions.

“Cyber-shot Viewer” overview

With the “Cyber-shot Viewer” you can:
• Import images shot with the camera and display them on the monitor.
• Organize images on the computer on a calendar by shooting date to view them.
• Retouch, print, and send still images as e-mail attachments, change the shooting date, and more.
• For details on the “Cyber-shot Viewer”, refer to the Help.

To access the Help, click [Start] → [Programs] (in Windows XP, [All Programs]) → [Sony Picture Utility] → [Help] → [Cyber-shot Viewer].

Basic instructions

Follow these steps to import and view images from the camera.

Importing images

1 Make sure “Media Check Tool”* is running.

* “Media Check Tool” is a program that automatically detects and imports images when a “Memory Stick” is inserted or when the camera is connected.

Look for a icon in the taskbar.
• If there is no icon: Click [Start] → [Programs] (in Windows XP, [All Programs]) → [Sony Picture Utility] → [Cyber-shot Viewer] → [Tools] → [Media Check Tool].

2 Connect the camera to your computer with the USB cable.

After the camera is automatically detected, the [Import Images] screen is displayed.

Starting and exiting the “Cyber-shot Viewer”

Starting the “Cyber-shot Viewer”

Double-click the (Cyber-shot Viewer) icon on the desktop.
Or, from the Start menu: Click [Start] → [Programs] (in Windows XP, [All Programs]) → [Sony Picture Utility] → [Cyber-shot Viewer].

Exiting the “Cyber-shot Viewer”

Click button in the top right corner of the screen.

• If you will use the “Memory Stick” slot, first refer to page 49.
• In Windows XP, if the AutoPlay Wizard appears, close it.
3 Import the images.

To start importing images, click the [Import] button.

By default, images are imported into a folder created in “My Pictures” that is named with the date of importing.
• For instructions on changing the “Folder to be imported”, refer to page 59.

Viewing images

1 Checking imported images

When importing is complete, the “Cyber-shot Viewer” starts. Thumbnails of the imported images are displayed.

• The “My Pictures” folder is set as the default folder in “Viewed folders”.
• You can double-click a thumbnail to display the image by itself.

2 Viewing images in “Viewed folders” arranged by shooting date on a calendar

① Click the [Calendar] tab. Years when images were shot are listed.
② Click the year. Images shot that year are displayed, arranged on the calendar by shooting date.
③ To display images by month, click the desired month. Thumbnails of images shot that month are displayed.
④ To display images by time, click the desired date. Thumbnails of images shot that day are displayed, arranged by hour.

Year display screen

Month display screen
Hour display screen

To list images from a particular year or month, click that period on the left of the screen.

3 Displaying individual images

On the hour display screen, double-click a thumbnail to display the image by itself in a separate window.

• You can edit displayed images by clicking the toolbar button.

Displaying images in full-screen mode

To display a slide show of current images in full-screen mode, click the button.

• To play or pause the slide show, click the button on the lower left of the screen.
• To stop the slide show, click the button on the lower left of the screen.
Other functions

Preparing images stored on the computer for viewing

To view them, register the folder that contains the images as one of the “Viewed folders”.
From the [File] menu, choose [Register Viewed Folders...] to display the settings screen for “Viewed folders” registration.

Click the [Add...] button, and then specify the folder with images for importing to register the folder as a “Viewed folder.”
- Images in any subfolders of “Viewed folders” are also registered.

Changing the “Folder to be imported”

To change the “Folder to be imported”, access the “Import Settings” screen.
To display the “Import Settings” screen, choose [Image Import Settings...] from the [File] menu.

Click [Start] → [Settings] → [Control Panel]. Double-click [Add/Remove Programs]. (For Windows XP, click [Start] → [Control Panel], then double-click [Add or Remove Programs].)

Select [Sony Picture Utility] and click [Change/Remove] (for Windows XP, [Remove]) to uninstall.

Updating image registration information

To update image information, choose [Update Database] from the [Tools] menu.
- Updating the database may take a while.
- If you rename image files or folders in “Viewed folders”, they cannot be displayed with this software. In this case, update the database.

Technical Support

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.
http://www.sony.net/
You can copy images to your computer.
• The supplied software is not compatible with Macintosh computers.

### Recommended computer environment

The following environment is recommended for a computer connected to the camera.

#### Recommended environment for copying images

- **OS (pre-installed):** Mac OS 9.1, 9.2 or Mac OS X (v10.0 or later)
- **USB jack:** Provided as standard

#### Notes on connecting your camera to a computer

- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- The [Normal] (default setting) mode is for a USB connection when connecting a computer. This section describes the [Normal] mode as an example.
- When your computer resumes from the suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

### Copying and viewing images on a computer

1. **Prepare the camera and a Macintosh computer.**
   Perform the same procedure as that described in “Stage 1: Preparing the camera and the computer” on page 49.

2. **Connect the USB cable.**
   Perform the same procedure as that described in “Stage 2: Connecting the camera and your computer” on page 50.

3. **Copy image files to the Macintosh computer.**
   ① Double-click the newly recognized icon → [DCIM] → the folder where the images you want to copy are stored.
   ② Drag and drop the image files to the hard disk icon.
   The image files are copied to the hard disk.
   • For details on the storage location of the images and file names, see page 54.

4. **View images on the computer.**
   Double-click the hard disk icon → the desired image file in the folder containing the copied files to open that image file.
Using your computer

To delete the USB connection

Perform the procedures listed below beforehand when:

• Disconnecting the USB cable
• Removing a “Memory Stick Duo”
• Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
• Turning off the camera

Drag and drop the drive icon or the icon of the “Memory Stick Duo” to the “Trash” icon.

The camera is disconnected from the computer.

• If you are using Mac OS X v10.0, perform the procedure above after you have turned your computer off.

Technical Support

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.
http://www.sony.net/
Printing still images

How to print still images

Printing directly using a PictBridge compliant printer (page 63)

You can print images by connecting the camera directly to a PictBridge compliant printer.

Printing directly using a “Memory Stick” compliant printer

You can print images with a “Memory Stick” compliant printer. For details, see the operating instructions supplied with the printer.

Printing using a computer

You can copy images to a computer using the “Cyber-shot Viewer” software in the supplied CD-ROM and print the images.

Printing at a shop (page 66)

You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. You can make a (Print order) mark on images that you want to print out in advance.
Printing images directly using a PictBridge compliant printer

Even if you do not have a computer, you can print images shot using your camera by connecting the camera directly to a PictBridge compliant printer.

PictBridge

• “PictBridge” is based on the CIPA standard.
(CIPA: Camera & Imaging Products Association)

In single-image mode
You can print a single image on a printing sheet.

In index mode
You can print several images at a reduced size on a printing sheet. You can print a set of either the same images (1) or different images (2).

1 • An index print function may not be provided depending on the printer.
2 • The quantity of images that can be printed as an index image differ depending on the printer.
3 • You cannot print movies.
4 • If the indicator flashes on the screen of the camera for about five seconds (error notification), check the connected printer.

Stage 1: Preparing the camera

Prepare the camera to connect it to the printer with the USB cable.

1 Press MENU to display the menu.

2 Press ➤ on the control button to select (Setup).

3 Select [ ] (Setup2) with ▼, then select [USB Connect] with ▲▼▲.

4 Select [PictBridge] with ▲▼, then press ●.

The USB mode is set.
**Stage 2: Connecting the camera to the printer**

1. Connect the (USB) jack on your camera and the USB jack on the printer with the supplied USB cable.

   ![USB connection]

2. Turn on your camera and the printer.

   After the connection is made, the indicator appears.

   ![Print menu]

   The camera is set to playback mode, then an image and the print menu appear on the screen.

**Stage 3: Printing**

Regardless of what the mode dial is set to, the print menu appears when you complete Stage 2.

1. Select the desired printing method with ▲/▼ on the control button, then press ●.

   - **[All In This Folder]**
     Prints all the images in the folder.
   - **[DPOF image]**
     Prints all the images with a (Print order) mark (page 66) regardless of the displayed image.
   - **[Select]**
     Selects images and prints all the selected images.

     ① Select the image you want to print with ◀/▶, then press ●.
     The mark appears on the selected image.
     • To select other images, repeat this procedure.

     ② Select [Print] with ▼, then press ●.

   - **[This image]**
     Prints a displayed image.
     • If you select [This image] and set [Index] to [On] in step 2, you can print a set of the same images as an index image.

2. Select print settings with ▲/▼/◀/▶.

   - **[Index]**
     Select [On] to print as an index image.
Printing still images

[Size]
Select the size of the printing sheet.

[Date]
Select [Day&Time] or [Date] to insert the date and time on images.
- When you choose [Date], the date will be inserted in the order you select. This function may not be provided depending on the printer.

[Quantity]
When [Index] is set to [Off]:
Select the number of sheets of an image that you want to print. The image will be printed as a single image.

When [Index] is set to [On]:
Select the number of sets of images that you want to print as an index image.
If you selected [This image] in step 1, select the number of the same image you want to print side by side on a sheet as an index image.
- The designated number of images may not all fit onto a single sheet depending on the quantity of images.

3 Select [OK] with ▼/▲, then press ●.

The image is printed.
- Do not disconnect the USB cable while the indicator appears on the screen.

To print other images
After step 3, select [Select] and the desired image with ▲/▼, then perform from step 1.

To print images on the index screen
Perform “Stage 1: Preparing the camera” (page 63) and “Stage 2: Connecting the camera to the printer” (page 64), then proceed with the following.

When you connect the camera to a printer, the print menu appears. Select [Cancel] to turn off the print menu, then proceed as follows.

① Press (Index).
   The index screen appears.

② Press MENU to display the menu.

③ Select [ ] (Print) with ▼, then press ●.

④ Select the desired printing method with ◀/▲, then press ●.

   [Select]
   Selects images and prints all the selected images.
   Select the image you want to print with ▲/▼/◀/▶, then press ● to display the mark. (Repeat this procedure to select other images.) Then, press MENU.

   [DPOF image]
   Prints all the images with a (Print order) mark regardless of the displayed image.

   [All In This Folder]
   Prints all the images in the folder.

⑤ Perform steps 2 and 3 of “Stage 3: Printing” (page 64).
Printing at a shop

You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. As long as the shop supports photo printing services conforming to the DPOF, you can make a (Print order) mark on images in advance so that you do not need to reselect them when you print them out at the shop.

• You cannot print images stored in the internal memory at a print shop directly from the camera. Copy the images to a “Memory Stick Duo”, then take the “Memory Stick Duo” to the print shop.

What is DPOF?

DPOF (Digital Print Order Format) is a function allowing you to make a (Print order) mark on images of “Memory Stick Duo” that you want to print out later.

• You can also print the images with the (Print order) mark using a printer that conforms to the DPOF (Digital Print Order Format) standard or using a PictBridge compliant printer.
• You cannot mark movies.

When taking a “Memory Stick Duo” to a shop

• Consult your photo printing service shop as to what types of “Memory Stick Duo” they handle.
• If a “Memory Stick Duo” is not handled by your photo printing service shop, copy the images you want to print out to other medium such as a CD-R and take it to the shop.
• When taking a “Memory Stick Duo”, be sure to prepare the Memory Stick Duo Adaptor (not supplied) with it.
• Before you take image data to a shop, always copy (back up) your data to a disk.
• You cannot set the number of prints.

Marking in single-image mode

1 Display the image you want to print.

2 Press MENU to display the menu.

3 Select DPOF with ◀/▶, then press ●.

A (Print order) mark is marked on the image.

4 To mark other images, display the desired image with ◀/▶, then press ●.

To remove the mark in single-image mode
Press ● in step 3 or 4.
**Marking in index mode**

1. Display the index screen.

2. Press MENU to display the menu.

3. Select DPOF with ◀/▶, then press ●.

4. Select [Select] with ▲/▼, then press ●.
   - You cannot add a 📒 mark in [All In This Folder].

5. Select the image you want to mark with ▲/▼/◀/▶, then press ●.
   A green 📒 mark appears on the selected image.

6. Repeat step 5 to mark other images.

7. Press MENU.

8. Select [OK] with ▶, then press ●.
   The 📒 mark turns white.

To remove the mark in index mode
Select the images from which you want to remove the mark in step 5, then press ●.

To remove all the marks in the folder
Select [All In This Folder] in step 4, then press ●. Select [Off], then press ●.

To cancel, select [Cancel] in step 4 or select [Exit] in step 8, then press ●.
Connecting your camera to your TV

Viewing images on a TV screen

You can view images on a TV screen by connecting the camera to a TV.

Turn off both your camera and the TV before connecting the camera and the TV with the A/V cable.

1. Connect the A/V cable (supplied) to the A/V OUT (MONO) jack of the camera and the audio/video input jacks of a TV.

   - If your TV has stereo input jacks, connect the audio plug (white) of the A/V cable to the left audio jack.

2. Turn on the TV and set the TV/video input switch to “video.”

   - For details, see the operating instructions supplied with the TV.

3. Set the mode dial to \( \text{ } \), and turn on the camera.

   Images shot with the camera appear on the TV screen.

   Press \( \text{ } / \text{ } \) on the control button to select the desired image.

   - When using your camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 44).
On TV color systems

If you want to view images on a TV screen, you need a TV with a video input jack and the A/V cable. The color system of the TV must match that of your digital still camera. Check the following lists for the color system of the country or region when the camera is used.

**NTSC system**
Bahama Islands, Bolivia, Canada, Central America, Chile, Colombia, Ecuador, Jamaica, Japan, Korea, Mexico, Peru, Surinam, Taiwan, the Philippines, the U.S.A., Venezuela, etc.

**PAL system**
Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, Germany, Holland, Hong Kong, Hungary, Italy, Kuwait, Malaysia, New Zealand, Norway, Poland, Portugal, Singapore, Slovak Republic, Spain, Sweden, Switzerland, Thailand, United Kingdom, etc.

**PAL-M system**
Brazil

**PAL-N system**
Argentina, Paraguay, Uruguay

**SECAM system**
Bulgaria, France, Guiana, Iran, Iraq, Monaco, Russia, Ukraine, etc.
If you experience trouble with your camera, try the following solutions.

1. Check the items on pages 71 to 80.

2. Remove the batteries, and insert the batteries again after about one minute, and turn on the power.

3. Initialize the settings (pages 43)

4. Consult your Sony dealer or local authorized Sony service facility.

Please understand that you give your consent that the contents of the internal memory may be checked when you send your camera to be repaired.
Batteries and power

The battery remaining indicator is incorrect, or sufficient battery remaining indicator is displayed but the power runs out too quickly.

- This phenomenon occurs when you use the camera in an extremely hot or cold location (page 85).
- When using alkaline batteries/Oxy Nickel Primary Battery (not supplied), the displayed time remaining may not be correctly indicated.
- The batteries are discharged. Install new batteries or charged Nickel-Metal Hydride batteries (not supplied).
- When using the Nickel-Metal Hydride batteries (not supplied), the poles of batteries or the terminals of the battery cover are dirty so the batteries are not charged sufficiently. Clean them with a cotton swab, etc. (page 85).
- When using the Nickel-Metal Hydride batteries (not supplied), the displayed time remaining differs from the current one due to the memory effect (page 85), etc. Fully discharge and then charge the batteries to correct the display.
- The batteries are dead. Replace them with new ones.

The batteries run down too quickly.

- You are using the camera in an extremely cold location (page 85).
- The batteries are dead. Replace them with new ones.
- When using the Nickel-Metal Hydride batteries (not supplied), charge them sufficiently.

Cannot turn on the camera.

- Install the batteries correctly.
- Properly connect the AC Adaptor (not supplied).
- The batteries are discharged. Install new batteries or charged Nickel-Metal Hydride batteries (not supplied).
- The batteries are dead. Replace them with new ones.

The power turns off suddenly.

- If you do not operate the camera for about three minutes while the power is on, the camera turns off automatically to prevent wearing down the batteries. Turn on the camera again.
- The batteries are discharged. Install new batteries or charged Nickel-Metal Hydride batteries (not supplied).

Shooting still images/movies

Your camera cannot record images.

- Check the free capacity of the internal memory or “Memory Stick Duo” (page 21). If it is full, do one of the following:
  - Delete unnecessary images.
  - Change the “Memory Stick Duo”.
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 83).
• You cannot record images while charging the flash.
• When shooting a still image, set the mode dial to a position other than 
• Set the mode dial to 

The subject is not visible on the screen.
• Set the mode dial to an other position than (page 24).

The image is out of focus.
• The subject is too close. Record in the close-up (Macro) recording mode. Make sure to position the lens farther away from the subject than the shortest shooting distance, approximately 5 cm (2 inches) (W)/35 cm (13 7/8 inches) (T), when shooting.
• (Twilight mode) or (Landscape mode) is selected as the Scene mode when you shoot still images.

Zoom does not work.
• You cannot change the zoom scale when shooting movies.

Precision digital zoom does not function.
• Set [Digital Zoom] to [Precision] (page 38).
• This function cannot be used while shooting movies.

Smart zoom does not function.
• Set [Digital Zoom] to [Smart] (page 38).
• This function cannot be used when:
  – The image size is set to [5M] or [3:2].
  – Shooting movies.

The flash does not work.
• The flash is set to (No flash).
• You cannot use the flash when:
  – [Mode] (REC Mode) is set to [Burst] (page 30).
  – (Twilight mode) or (Candle mode) of the Scene mode, or (movie) is selected.
• Set the flash to (Forced flash) to shoot still images when (Landscape mode), or (Beach mode) is selected as the Scene mode.

The close-up (Macro) function does not work.
• (Twilight mode), (Landscape mode), or (Candle mode) is selected for the Scene mode (page 25).

Fuzzy specks appear in images shot using the flash.
• Dust in the air reflected the flash light and appeared in the image. This is not a malfunction.
Troubleshooting

**The date and time are not displayed.**
- While shooting, the date and time are not displayed. Only during playback, the date and time are displayed.

**The date and time are recorded incorrectly.**
- Set the correct date and time.

**The F value and shutter speed flash when you press and hold the shutter button halfway down.**
- The exposure is incorrect. Correct the exposure (page 28).

**The image is too dark.**
- You are shooting a subject with a light source behind the subject. Select the metering mode (page 28) or adjust the exposure (page 28).
- The brightness of the screen is too low. Adjust the brightness of the LCD backlight (page 43).

**The image is too bright.**
- You are shooting a spotlighted subject in a dark location such as on a stage. Adjust the exposure (page 28).
- The brightness of the screen is too bright. Adjust the brightness of the LCD backlight (page 43).

**The image colors are not correct.**

**Vertical streaks appear when you are shooting a very bright subject.**
- The smear phenomenon is occurring. This phenomenon is not a malfunction.

**Noise appears in the image when you view the screen in a dark place.**
- The camera is attempting to increase the visibility of the screen by temporarily brightening the image under conditions of low illumination. There is no effect on the recorded image.

**The eyes of the subject come out red.**
- Set [Red Eye Reduction] in the (Setup) menu to [On] (page 39).
- Shoot the subject at a distance closer than the recommended shooting distance using the flash.
- Light the room and shoot the subject.

**Dots appear and remain on the screen.**
- This is not a malfunction. These dots are not recorded.
Cannot shoot images in succession.

- The internal memory or the “Memory Stick Duo” is full. Delete unnecessary images.
- The battery level is low. Install charged batteries or replace with new ones.

Viewing images
Refer to “Computers” (page 75) in conjunction with the following items.

Your camera cannot play back images.

- Set the mode dial to 📹 (page 24).
- The folder/file name has been changed on your computer.
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- The camera is in USB mode. Delete the USB communication (page 53).

The date and time are not displayed.

- |☐| (Screen status) button is turned off (page 20).

The image appears rough right after playback starts.

- The image may appear rough right after playback starts due to image processing. This is not a malfunction.

The image does not appear on the TV screen.

- Check [Video Out] to see if the video output signal of your camera is set to the color system of your TV (page 44).
- Check whether the connection is correct (page 68).
- The USB cable is connected to the USB jack. Disconnect it according to the correct procedure (page 53).

The image does not appear on the screen.

- If the A/V cable is connected, disconnect it (page 68).

No recorded sound is played back with movies on the camera.

- The sound recorded with moives can only be played back on TV, PC.
Deleting/Editing images

Your camera cannot delete an image.
• Cancel the protection (page 34).
• Set the write-protect switch on the “Memory Stick Duo” to the recording position (page 83).

You have deleted an image by mistake.
• Once you have deleted an image, you cannot restore it. We recommend that you set protection on an image (page 33), or set the write-protect switch on the “Memory Stick Duo” to the LOCK position (page 83) to prevent accidental erasure.

You cannot display a DPOF (Print order) mark.
• You cannot display DPOF (Print order) marks on movies.

Computers

You do not know if the OS of your computer is compatible with the camera.
• Check “Recommended computer environment” on page 47 for windows and page 60 for Macintosh.

Your computer does not recognize your camera.
• Turn on the camera.
• When the battery level is low, install the charged batteries, replace the batteries with new ones, or use the AC Adaptor (not supplied).
• Use the supplied USB cable.
• Disconnect the USB cable from both the computer and the camera, and connect it again firmly. Make sure that “USB Mode Normal” is displayed (page 50).
• Set [USB Connect] to [Normal] in the (Setup) menu (page 44).
• Disconnect all equipment other than the camera, the keyboard and the mouse from the USB connectors of your computer.
• Connect the camera directly to your computer without passing through a USB hub or other device (page 50).
You cannot copy images.

- Connect the camera and your computer correctly using the USB cable (page 50).
- Follow the designated copy procedure for your OS (pages 50, 60).
- When you shoot images with a “Memory Stick Duo” formatted by a computer, you may not be able to copy the images to a computer. Shoot using a “Memory Stick Duo” formatted by your camera (page 41).

After making a USB connection, “Cyber-shot Viewer” does not start automatically.

- Start “Media Check Tool” (page 56).
- Make the USB connection after the computer is turned on (page 50).

The image cannot be played back on a computer.

- If you are using “Cyber-shot Viewer”, refer to the Help.
- Consult the computer or software manufacturer.

The image and sound are interrupted by noise when you view a movie on a computer.

- You are playing back the movie directly from the internal memory or the “Memory Stick Duo”. Copy the movie to the hard disk of your computer, then play back the movie from the hard disk (page 49).

You cannot print an image.

- Check the printer settings.

Images once copied to a computer cannot be viewed on the camera.

- Copy them to a folder recognized by the camera, such as “101MSDCF” (page 54).
- Operate correctly (page 55).
“Cyber-shot Viewer”

Images are not displayed correctly with “Cyber-shot Viewer”.

- Make sure the folder of the images is registered in “Viewed folders”. If the images are not displayed even if the folder is registered in “Viewed folders”, update the database (page 59).

You cannot find images imported with “Cyber-shot Viewer”.

- Look in the “My Pictures” folder.
- If you have changed the default settings, refer to (page 59) and check what folder is used for importing.

You want to change the “Folder to be imported”.

- Access the “Import Settings” screen to change “Folder to be imported”. You can specify a different folder after using “Cyber-shot Viewer” to register it in “Viewed folders” (page 59).

All imported images are displayed on the calendar with the date January 1.

- The date has not been set on the camera. Set the date on the camera.

“Memory Stick Duo”

Cannot insert a “Memory Stick Duo”.

- Insert it in the correct direction.

Cannot record on a “Memory Stick Duo”.

- Set the write-protect switch on the “Memory Stick Duo” to the recording position (page 83).
- The “Memory Stick Duo” is full. Delete unnecessary images.

Cannot format a “Memory Stick Duo”.

- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 83).

You have formatted a “Memory Stick Duo” by mistake.

- All the data on the “Memory Stick Duo” is deleted by formatting. You cannot restore it. We recommend that you set the write-protect switch on the “Memory Stick Duo” to the LOCK position to prevent accidental erasure (page 83).

“Memory Stick PRO Duo” is not recognized by a computer with a “Memory Stick” slot.

- Check whether the computer and the card reader support “Memory Stick PRO Duo”. Users of computers and card readers made by companies other than Sony should contact those manufacturers.
• If “Memory Stick PRO Duo” is not supported, connect the camera to the computer (page 50). The computer recognizes the “Memory Stick PRO Duo”.

### Internal memory

**The camera or your computer cannot play back the data in the internal memory.**

• There is a “Memory Stick Duo” inserted in the camera. Remove it.

**Cannot record images using the internal memory.**

• There is a “Memory Stick Duo” inserted in the camera. Remove it.

**The free capacity of the internal memory does not increase even when you copy the data stored in the internal memory to a “Memory Stick Duo”.

• The data is not deleted after copying. Execute the [Format] command (page 40) to format the internal memory after copying the data.

**Cannot copy the data stored in the internal memory to a “Memory Stick Duo”.

• The “Memory Stick Duo” is full. Check the capacity.

**Cannot copy the data on the “Memory Stick Duo” or the computer to the internal memory.

• Data on a “Memory Stick Duo” or a computer cannot be copied to the internal memory.

### Printing

Also see “PictBridge compliant printer” (as follows) in conjunction with the following items.

**Images are printed with both edges cut off.**

• When printing images using your own printer, try canceling the trimming or borderless settings. Consult the printer manufacturer as to whether the printer provides these functions or not.

• When having images printed at a digital print shop, ask the shop whether they can print the images without cutting off both edges.

### PictBridge compliant printer

**A connection cannot be established.**

• The camera cannot be connected directly to a printer that is not compliant with the PictBridge standard. Consult the printer manufacturer as to whether the printer is compliant with PictBridge or not.

• Check that the printer is turned on and can be connected to the camera.

• Set [USB Connect] to [PictBridge] in the (Setup) menu (page 44).

• Disconnect and connect the USB cable again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.
Cannot print images.

- Check that the camera and the printer are properly connected using the USB cable.
- Turn on the printer. For further information, refer to the operating instructions supplied with it.
- If you select [Exit] during printing, images may not print. Disconnect and connect the USB cable again. If you still cannot print your images, disconnect the cable, turn the printer off and then on, then connect the cable again.
- Movies cannot be printed.
- Images shot using cameras other than this camera or images modified with a computer may not be printed.

Printing is canceled.

- You disconnected the USB cable before the (Do not disconnect the USB cable) mark disappears.

Cannot insert the date or print images in the index mode.

- The printer does not provide these functions. Consult the printer manufacturer as to whether the printer provides these functions or not.
- The date may not be inserted in the index mode depending on the printer. Consult the printer manufacturer.

“---- -- --” is printed on the date-inserted part of the image.

- Images that do not have the recording data cannot be printed with the date inserted. Set [Date] to [Off] and print the image again (page 65).

Cannot select the print size.

- Consult the printer manufacturer as to whether the printer can provide the desired size.

Cannot print the image at the size selected.

- If you have changed the paper size after having the USB cable connected, then connect the printer again.
- The print setting of the camera differs from that of the printer. Change the setting of either the camera (page 65) or the printer.

Cannot operate the camera after canceling printing.

- Wait for a while as the printer is carrying out the cancellation. It may take some time depending on the printer.
Others

Your camera does not work.

- Use the type of batteries you can use with this camera (page 85).
- The battery level is low (The \( \mathcal{E} \) indicator appears). Install new batteries or charged Nickel-Metal Hydride batteries (not supplied).

The power is on, but the camera does not work.

- The built-in microcomputer is not working properly. Remove the batteries, and then, after one minute, insert the batteries and turn on the camera.

Cannot identify an indicator on the screen.

- See page 16.

The lens gets fogged.

- Moisture condensation has occurred. Turn off the camera and leave it for about an hour before using it (page 87).

The camera becomes warm when you use it for a long time.

- This is not a malfunction.

The lens does not move when you turn off the camera.

- The batteries are discharged. Install new batteries or charged Nickel-Metal Hydride batteries (not supplied) or use the AC Adaptor (not supplied).

The Clock Set screen appears when you turn on the camera.

- Set the date and time again.

The power of camera is turned off automatically when you remove the Memory Stick Duo under power on status.

- This is not a malfunction. Turn off the camera before you remove the Memory Stick Duo.
Warning messages

Messages
If the following messages appear, follow the instructions.

Turn the power off and on again
• A problem with the lens has caused an error.

The battery level is low. Install new ones or charged Nickel-Metal Hydride batteries (not supplied). Depending on the conditions of use or the type of battery, the indicator may flash even though there are still 5 to 10 minutes of remaining battery time left.

System error
• Turn the power off and then on again.

Internal memory error
• Turn the power off and then on again.

Reinsert the Memory Stick
• Insert the “Memory Stick Duo” correctly.
• The inserted “Memory Stick Duo” cannot be used in your camera (page 83).
• The “Memory Stick Duo” is damaged.
• The terminal section of the “Memory Stick Duo” is dirty.

Memory Stick type error
• The inserted “Memory Stick Duo” cannot be used in your camera (page 83).

Format error
• Format the media again (pages 41).

Memory Stick locked
• You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 83).

No memory space in internal memory
No memory space in Memory Stick
• Delete unnecessary images or files.

Read only memory
• Your camera cannot record or delete images on this “Memory Stick Duo”.

No file
• No images have been recorded in the internal memory.

No file in this folder
• No images have been recorded in this folder.
• You did not operate correctly when copying images from your computer (page 55).

Folder error
• A folder with the same first three digit number already exists on the “Memory Stick Duo”. (For example: 123MSDCF and 123ABCDE) Select other folders, or create a new folder (page 41).

Cannot create more folders
• The folder with a name beginning with “999” exists on the “Memory Stick Duo”. You cannot create any folders if this is the case.
Cannot record

• The camera cannot record images in the selected folder. Select a different folder (page 42).

File error

• An error occurred while the image was playing back.

File protect

• Release the protection (page 34).

Image size over

• You are playing back an image of a size that cannot be played back on your camera.

Invalid operation

• You are trying to play back a file that is not compatible with the camera.

Enable printer to connect

• [USB Connect] is set to [PictBridge], however the camera is connected to a non-PictBridge compliant device. Check the device.
• The connection is not established. Disconnect and connect the USB cable again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

Connect to PictBridge device

• You tried to print images before the printer connection was established. Connect to a PictBridge compliant printer.

No printable image

• You tried to execute [DPOF image] without placing a DPOF (Print order) mark on the image(s).
• You tried to execute [All In This Folder] while a folder that holds only movies was selected. You cannot print movies.

Printer busy

Paper error
No Paper

Ink error
Low Ink
No Ink

• Check the printer.

Printer error

• Check the printer.
• Check if the image you want to print is corrupted.

• The data transmission to the printer may not be completed yet. Do not disconnect the USB cable.

Processing

• The printer is canceling the current print job. You cannot print until it is finished. This may take time, depending on the printer.
A “Memory Stick” is a compact, portable IC recording medium. The types of “Memory Stick” that can be used with this camera are listed in the table below. However, proper operation cannot be guaranteed for all “Memory Stick” functions.

**Notes on using a “Memory Stick Duo” (not supplied)**

- You cannot record, edit or delete images if you slide the write-protect switch to LOCK with a fine-tipped object.

Some “Memory Stick Duo” cards do not have a write-protect switch. On “Memory Stick Duo” with this switch, the position and shape may vary depending on the “Memory Stick Duo”.

- Do not remove the “Memory Stick Duo” while reading or writing data.
- Data may be corrupted in the following cases:
  - When the “Memory Stick Duo” is removed or the camera is turned off during a read or write operation
  - When the “Memory Stick Duo” is used in locations subject to static electricity or electrical noise
- We recommend backing up important data.
- Do not press down hard when you write down on the memo area.
- Do not attach a label on the “Memory Stick Duo” itself nor on a Memory Stick Duo Adaptor (not supplied).
- When you carry or store the “Memory Stick Duo”, put it in the case supplied with it.
- Do not touch the terminal section of the “Memory Stick Duo” with your hand or a metal object.
- Do not strike, bend or drop the “Memory Stick Duo”.
- Do not disassemble or modify the “Memory Stick Duo”.
- Do not expose the “Memory Stick Duo” to water.
- Do not leave the “Memory Stick Duo” within the reach of small children. They might accidentally swallow it.

<table>
<thead>
<tr>
<th>“Memory Stick” type</th>
<th>Recording/Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Stick (without MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick (with MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick Duo (without MagicGate)</td>
<td>○</td>
</tr>
<tr>
<td>Memory Stick Duo (with MagicGate)</td>
<td>○<em>1</em>2</td>
</tr>
<tr>
<td>MagicGate Memory Stick</td>
<td>—</td>
</tr>
<tr>
<td>MagicGate Memory Stick Duo</td>
<td>○*1</td>
</tr>
<tr>
<td>Memory Stick PRO</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick PRO Duo</td>
<td>○<em>1</em>2</td>
</tr>
</tbody>
</table>

*1 “Memory Stick Duo”, “MagicGate Memory Stick Duo” and “Memory Stick PRO Duo” are equipped with MagicGate functions. MagicGate is copyright protection technology that uses encryption technology. Data recording/playback that requires MagicGate functions cannot be performed with this camera.

*2 Supports high-speed data transfer using a parallel interface.

- A “Memory Stick Duo” formatted with a computer is not guaranteed to operate with this camera.
- Data read/write speeds differ depending on the combination of the “Memory Stick Duo” and the equipment used.
• Do not use or store the “Memory Stick Duo” under the following conditions:
  – High temperature locations such as the hot interior of a car parked in direct sunlight
  – Locations exposed to direct sunlight
  – Humid locations or locations with corrosive substances present

**Notes on using the Memory Stick Duo Adaptor (not supplied)**

• To use a “Memory Stick Duo” with a “Memory Stick” compliant device, be sure to insert the “Memory Stick Duo” into a Memory Stick Duo Adaptor. If you insert a “Memory Stick Duo” into a “Memory Stick” compliant device without a Memory Stick Duo Adaptor, you might not be able to remove it from the device.

• When inserting a “Memory Stick Duo” into a Memory Stick Duo Adaptor, make sure the “Memory Stick Duo” is inserted facing in the correct direction, then insert it all the way in. Incorrect insertion may result in a malfunction.

• When using a “Memory Stick Duo” inserted into a Memory Stick Duo Adaptor with a “Memory Stick” compliant device, make sure that the Memory Stick Duo Adaptor is inserted facing the correct direction. Note that improper use may damage the equipment.

• Do not insert a Memory Stick Duo Adaptor into a “Memory Stick” compliant device without a “Memory Stick Duo” attached. Doing so may result in malfunction of the unit.

**Notes on using “Memory Stick PRO Duo” (not supplied)**

“Memory Stick PRO Duo” with a capacity up to 2 GB have been confirmed to operate properly with this camera.
On the batteries

Batteries you can use with your camera

LR6 (size AA) alkaline batteries (2) (supplied / non-rechargeable)
HR 15/51:HR6 (size AA) Nickel-Metal Hydride batteries (2) (not supplied / rechargeable)
- NH-AA-2DB twin pack, etc.
ZR6 (size AA) Oxy Nickel Primary Battery (2) (not supplied / non-rechargeable)

Batteries you cannot use with your camera

Manganese batteries
Lithium batteries
Ni-Cd batteries
If you use the above batteries, we cannot guarantee full performance of the camera by property of the batteries, such as brownout of the batteries.

On alkaline batteries/Oxy Nickel Primary Battery

- Alkaline batteries/Oxy Nickel Primary Battery have a shorter life compared to the Nickel-Metal Hydride batteries. For this reason, the power may turn off even though the battery remaining indicator shows sufficient battery life remaining.
- Battery performance differs greatly depending on the manufacturer and the type of battery, and in some cases the battery life may be extremely short. This is especially true at low temperatures, and you may not be able to shoot at temperatures below 5°C (41°F).
- Do not mix new and old batteries.
- The battery remaining indicator may not display the correct information when using alkaline batteries/Oxy Nickel Primary Battery.
- Due to characteristics of alkaline batteries/Oxy Nickel Primary Battery, there is a large difference between the available shooting time and the available playback time. For this reason, the camera may turn off with the lens portion extended when you switch the mode dial. In this case, replace the batteries with new ones or fully charged Nickel-Metal Hydride batteries.

On Nickel-Metal Hydride batteries

- Do not peel off the external seals or damage the batteries. Never use batteries from which the seals have been partially or completely removed, or batteries that have been split in any way. These may cause leakage, explosion, or heat-up of the battery, and personal scald or injury may be caused. These may cause a malfunction of the battery charger.
- Always carry the Nickel-Metal Hydride batteries in the battery case. Otherwise, metallic objects may short the + and - ends, resulting in the risk of heating or fire.
- If the poles of the Nickel-Metal Hydride batteries are dirty, the batteries may not charge properly. Wipe them with a dry cloth, etc.
- At the time of purchase, or when the Nickel-Metal Hydride batteries have not been used for a long time, they may not full charge. This is typical of this type of battery, and is not a malfunction. If this happens, repeatedly using up the batteries fully, and then recharging them should correct the problem.
- If you recharge Nickel-Metal Hydride batteries before fully using up the existing charge, the low battery warning may be displayed sooner than expected. This is called the “memory effect.”* If this problem occurs, charging the batteries only after using up the existing charge will correct it.
  * The “memory effect” - the situation in which the capacity of the battery is temporarily lowered.
- To use up the batteries completely, put the camera in the slide show mode (page 34) and leave it that way until the batteries are used up.
- Do not mix new and used batteries.
- Do not expose the battery to water. The battery is not water-resistant.
Effective use of Nickel-Metal Hydride batteries

- Batteries are discharged even when they are not used. We recommend you charge the batteries just before using them.
- Battery performance decreases in low-temperature surroundings, and the battery life is shortened under such circumstances. To use the battery longer, we recommend you keep the battery in its case in a pocket close to your body to warm it, and insert it in your camera just before you start shooting.
- If the poles of the batteries and the terminals on the battery cover of the camera are dirty, the battery life may be extremely shortened. Occasionally wipe them with a dry cloth, etc. to keep them clean.
- If you shoot a lot using the flash and the zoom, the battery power will be used up faster.
- We recommend having spare batteries handy for two or three times the expected shooting time, and try test shooting before actually using the camera.

Battery life of Nickel-Metal Hydride batteries

- The battery life is limited. The battery capacity decreases little by little as you use it more and more, and as time passes. When the battery operating time seems to have been considerably shortened, a probable cause is that the batteries have reached the end of their life.
- The battery life varies depending on storage, operating conditions, and environment, and is different for each battery.
Precautions

Do not leave the camera in the following places

- In an extremely hot place
  In places such as in a car parked in the sun, the camera body may become deformed and this may cause a malfunction.
- Under direct sunlight or near a heater
  The camera body may become discolored or deformed, and this may cause a malfunction.
- In a location subject to rocking vibration
- Near strong magnetic place
- In sandy or dusty places
  Be careful not to let sand or dust get into the camera. This may cause the camera to malfunction, and in some cases this malfunction cannot be repaired.

On cleaning

Cleaning the LCD screen
Wipe the screen surface with an LCD cleaning kit (not supplied) to remove fingerprints, dust, etc.

Cleaning the lens
Wipe the lens with a soft cloth to remove fingerprints, dust, etc.

Cleaning the camera surface
Clean the camera surface with a soft cloth slightly moistened with water, then wipe the surface with a dry cloth. Do not use the following as they may damage the finish or the casing.
- Chemical products such as thinner, benzine, alcohol, disposable cloths, insect repellent, sunscreen or insecticide, etc.
- Do not touch the camera with the above on your hand.
- Do not leave the camera in contact with rubber or vinyl for a long time.

On operating temperatures
Your camera is designed for use under the temperatures between 0°C and 40°C (32°F and 104°F). (In case of alkaline batteries/Oxy Nickel Primary Battery, the temperatures are between 5°C and 40°C (41°F and 104°F).) Shooting in extremely cold or hot places that exceed this range is not recommended.

On moisture condensation
If the camera is brought directly from a cold to a warm location, moisture may condense inside or outside the camera. This moisture condensation may cause a malfunction of the camera.

Moisture condensation occurs easily when:
- The camera is brought from a cold location such as a ski slope into a warmly heated room
- The camera is taken from an air-conditioned room or car interior to the hot outdoors, etc.

How to prevent moisture condensation
When bringing the camera from a cold place to a warm place, seal the camera in a plastic bag and allow it to adapt to conditions at the new location over about an hour.

If moisture condensation occurs
Turn off the camera and wait about an hour for the moisture to evaporate. Note that if you attempt to shoot with moisture remaining inside the lens, you will be unable to record clear images.

On the internal rechargeable battery
This camera has an internal rechargeable battery for maintaining the date and time and other settings regardless of whether the power is on or off.

This rechargeable battery is continually charged as long as you are using the camera. However, if you use the camera for only short periods, it discharges gradually, and if you do not use the camera at all for about one week it becomes completely discharged. In this case, be sure to charge this rechargeable battery before using the camera.

However, even if this rechargeable battery is not charged, you can still use the camera as long as you do not record the date and time.

Charging method
Insert batteries with enough capacity in the camera, or connect the camera to a wall outlet (wall socket) using the AC Adaptor (not supplied), and leave the camera for 24 hours or more with the power off.
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong></td>
</tr>
<tr>
<td>A/V cable .................................................. 68</td>
</tr>
<tr>
<td>Aperture .................................................. 10</td>
</tr>
<tr>
<td>Auto Focus ................................................ 9</td>
</tr>
<tr>
<td>Auto Review ............................................. 39</td>
</tr>
<tr>
<td>AVI ........................................................... 54</td>
</tr>
<tr>
<td><strong>B</strong></td>
</tr>
<tr>
<td>Back up ...................................................... 22</td>
</tr>
<tr>
<td>Beep .......................................................... 43</td>
</tr>
<tr>
<td>Blur ........................................................... 9</td>
</tr>
<tr>
<td>Burst .......................................................... 30</td>
</tr>
<tr>
<td><strong>C</strong></td>
</tr>
<tr>
<td>Camera ....................................................... 38</td>
</tr>
<tr>
<td>CD-ROM ....................................................... 48</td>
</tr>
<tr>
<td>Change REC. Folder .................................... 42</td>
</tr>
<tr>
<td>Cleaning ..................................................... 87</td>
</tr>
<tr>
<td>Clock Set .................................................... 45</td>
</tr>
<tr>
<td>Cloudy ......................................................... 29</td>
</tr>
<tr>
<td>Color ........................................................ 11</td>
</tr>
<tr>
<td>Compression ratio ................................. 13</td>
</tr>
<tr>
<td>Computer</td>
</tr>
<tr>
<td>Copying images ........................................... 49</td>
</tr>
<tr>
<td>Recommended environment ......................... 47</td>
</tr>
<tr>
<td>Software .................................................... 48</td>
</tr>
<tr>
<td>Viewing image files stored on a computer with your camera ................. 55</td>
</tr>
<tr>
<td>Windows ..................................................... 46</td>
</tr>
<tr>
<td>Connecting</td>
</tr>
<tr>
<td>Computer .................................................... 50</td>
</tr>
<tr>
<td>Printer ....................................................... 64</td>
</tr>
<tr>
<td>TV ............................................................... 68</td>
</tr>
<tr>
<td>Copy .......................................................... 42</td>
</tr>
<tr>
<td>Copying images to your computer .................. 49</td>
</tr>
<tr>
<td>Create REC. Folder ...................................... 41</td>
</tr>
<tr>
<td>Cyber-shot Viewer ......................................... 56</td>
</tr>
<tr>
<td><strong>D</strong></td>
</tr>
<tr>
<td>Date ............................................................ 39</td>
</tr>
<tr>
<td>Date/Time ................................................... 39</td>
</tr>
<tr>
<td>Day&amp;Time .................................................... 39</td>
</tr>
<tr>
<td>Daylight ..................................................... 29</td>
</tr>
<tr>
<td>Delete .......................................................... 15</td>
</tr>
<tr>
<td>Digital Zoom ............................................... 38</td>
</tr>
<tr>
<td>DPOF .......................................................... 66</td>
</tr>
<tr>
<td><strong>E</strong></td>
</tr>
<tr>
<td>Enlarging an image ....................................... 38</td>
</tr>
<tr>
<td>EV .............................................................. 28</td>
</tr>
<tr>
<td>Exposure ...................................................... 10</td>
</tr>
<tr>
<td>Extension .................................................... 55</td>
</tr>
<tr>
<td><strong>F</strong></td>
</tr>
<tr>
<td>File name .................................................... 54</td>
</tr>
<tr>
<td>File Number ............................................... 44</td>
</tr>
<tr>
<td>File storage destination ............................. 54</td>
</tr>
<tr>
<td>Fine ............................................................ 29</td>
</tr>
<tr>
<td>Fluorescent .................................................. 29</td>
</tr>
<tr>
<td>Focus .......................................................... 9</td>
</tr>
<tr>
<td>Folder ........................................................ 32</td>
</tr>
<tr>
<td>Changing ..................................................... 42</td>
</tr>
<tr>
<td>Creating ...................................................... 41</td>
</tr>
<tr>
<td>Format .......................................................... 41</td>
</tr>
<tr>
<td><strong>I</strong></td>
</tr>
<tr>
<td>Identifying parts .......................................... 14</td>
</tr>
<tr>
<td>Image file storage destinations and file names ......................... 54</td>
</tr>
<tr>
<td>Image quality ............................................. 12, 29</td>
</tr>
<tr>
<td>Image size ................................................... 12</td>
</tr>
<tr>
<td>Incandescent ............................................... 29</td>
</tr>
<tr>
<td>Index mode .................................................. 63</td>
</tr>
<tr>
<td>Index screen ............................................... 33</td>
</tr>
<tr>
<td>Indicator ..................................................... 33</td>
</tr>
<tr>
<td>Initialize ..................................................... 43</td>
</tr>
<tr>
<td>Install .......................................................... 48</td>
</tr>
<tr>
<td>Internal memory .......................................... 22</td>
</tr>
<tr>
<td>Internal Memory Tool ................................. 40</td>
</tr>
<tr>
<td>Internal rechargeable battery .......................... 87</td>
</tr>
<tr>
<td>ISO ........................................................ 10, 11, 29</td>
</tr>
<tr>
<td><strong>J</strong></td>
</tr>
<tr>
<td>JPG .............................................................. 54</td>
</tr>
<tr>
<td><strong>L</strong></td>
</tr>
<tr>
<td>LCD Backlight ............................................. 43</td>
</tr>
<tr>
<td>LCD screen ......... see “Screen”</td>
</tr>
<tr>
<td><strong>M</strong></td>
</tr>
<tr>
<td>Macintosh computer</td>
</tr>
<tr>
<td>Recommended environment ......................... 60</td>
</tr>
<tr>
<td>“Memory Stick Duo” .................................... 83</td>
</tr>
<tr>
<td>Format ......................................................... 41</td>
</tr>
<tr>
<td>Number of images/ recording time .................. 21</td>
</tr>
<tr>
<td>Write-protect switch .................................... 83</td>
</tr>
<tr>
<td>Memory Stick Tool ........................................ 41</td>
</tr>
<tr>
<td>Menu .......................................................... 26</td>
</tr>
<tr>
<td>Items .......................................................... 27</td>
</tr>
<tr>
<td>Shooting ...................................................... 28</td>
</tr>
<tr>
<td>Viewing ....................................................... 32</td>
</tr>
<tr>
<td>Metering Mode .............................................. 28</td>
</tr>
<tr>
<td>Mode ........................................................ 30</td>
</tr>
<tr>
<td>Moisture condensation .............................. 87</td>
</tr>
<tr>
<td>Monochrome ................................................. 30</td>
</tr>
<tr>
<td>Multi-pattern metering ......................... 28</td>
</tr>
<tr>
<td><strong>N</strong></td>
</tr>
<tr>
<td>NTSC ......................................................... 44</td>
</tr>
<tr>
<td>Number of images/Recording time .................. 21</td>
</tr>
<tr>
<td><strong>O</strong></td>
</tr>
<tr>
<td>Optical zoom ............................................... 38</td>
</tr>
<tr>
<td>OS ............................................................. 47</td>
</tr>
<tr>
<td>Overexposure ................................................. 10</td>
</tr>
</tbody>
</table>
P  
P.Effect .................................30  
PAL.......................................44  
PC ...................see “Computer”  
PFX .......................................30  
PictBridge .............................63  
Picture effect.........................30  
Pixel ......................................12  
Playback............ see “Viewing”  
Playback/Edit........................24  
Precautions ......................87  
Precision digital zoom ..........38  
Pressing halfway down...........9  
Print ......................................62  
   Index mode ....................63  
   Single-image mode........63  
Print order mark ....................66  
Printing at a shop .................66  
Printing directly ....................63  
Program auto shooting ......24  
Protect ...................................33  

R  
REC Mode ............................30  
Red Eye Reduction ...............39  
Resize....................................35  
Rotate....................................36  

S  
Saturation..............................31  
Screen  
   Changing the display ....20  
   Indicator .........................16  
   LCD Backlight ..............43  
Sepia .....................................30  
Setup .............................31, 36, 37  
   Camera ...........................38  
   Memory Stick Tool ..........41  
   Setup 1 .........................43  
   Setup 2 .........................44  
Setup 1.................................43  
Setup 2.................................44  
Sharpness .............................31  
Shooting menu ....................28  
Shooting movies.................24  
Single-image mode ..........63  
Slide .................................34  
Smart zoom .......................38  
Software ..............................48  
Spot metering ....................28  
Spot metering cross hairs ...28  
Standard .............................29  

T  
Tripod receptacle ............14  
Troubleshooting ................70  
TV ....................................68  

U  
Underexposure ................10  
USB cable ...........................19  
USB Connect .......................44  

V  
Video Out ............................44  
Viewing  
   Movie ............................56  
   Still image ......................56  
Viewing menu ...................32  

W  
Warning indicators and  
   messages  ......................81  
WB ....................................29  
White balance ....................29  
Windows computer ................46  
   Recommended  
      environment ..................47  
Write-protect switch ...........83
Trademarks

- **Cyber-shot** is a trademark of Sony Corporation.
- “Memory Stick”, “Memory Stick PRO”, Memory Stick PRO Duo”, “Memory Stick Duo”, Memory Stick PRO Duo”, “MagicGate”, and MagicGate are trademarks of Sony Corporation.
- Microsoft, Windows and DirectX are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- Macintosh and Mac OS are trademarks or registered trademarks of Apple Computer, Inc.
- Intel, MMX, and Pentium are trademarks or registered trademarks of Intel Corporation.
- In addition, system and product names used in this manual are, in general, trademarks or registered trademarks of their respective developers or manufacturers. However, the™ or ® marks are not used in all cases in this manual.
Additional information on this product and answers to frequently asked questions can be found at our Customer Support Website.

http://www.sony.net/